# Table of Contents

1. General ................................................................. Page 1  
   1.1. About these operating instructions .............................. Page 1  

2. Legal Notes .......................................................... Page 2  

3. Intended use/purpose .................................................. Page 4  

4. Explanation of Document Symbols .................................. Page 5  

5. Dimensions ........................................................... Page 7  
   5.1. Leica TCS SP2 MP System (direct coupling) .................. Page 7  
   5.2. Leica TCS SP2 MP System (fiber coupling) ................. Page 9  
   5.3. Technical Specifications and connection requirements     
        for TCS SP2 MP .................................................. Page 10  

6. Description of the multiphoton IR laser system ............ Page 11  
   6.1. Specifications of the multiphoton IR laser system ........ Page 11  
   6.2. Details of the laser safety housing for the beam coupling Page 11  
   6.3. Installation of the multiphoton IR laser system .......... Page 12  
   6.4. Laser system warranty ........................................ Page 12  
   6.5. Service calls and product modifications .................... Page 12  

7. General Safety Notes ................................................ Page 13  
   7.1. Safety Notes for the User ..................................... Page 13  
   7.2. Which standards does this product meet? .................... Page 13  
   7.3. What should the user of the laser scanning microscope observe? Page 14  
   7.4. Operational reliability ....................................... Page 15  
      7.4.1. De-energizing the system ............................... Page 15  
      7.4.2. Maximum current load of the power outlet strip     
             at the supply unit ..................................... Page 15  
   7.5. Laser safety .................................................. Page 16  
      7.5.1. Which laser class does this product have? .......... Page 16  
      7.5.2. Safety notes for operating the laser scanning microscope Page 17  
      7.5.3. Transmitted light lamp housing at upright stands  Page 19
Table of Contents

7.5.4. Eye protection .............................................................. Page 20

7.6. What laser safety devices does the laser scanning microscope have? ........................................ Page 21

7.6.1. Shielding ................................................................. Page 21

7.6.2. Detachable-key switch .................................................. Page 22

7.6.3. Emissions warning indicators ....................................... Page 23

7.6.4. Remote interlock connector on the supply unit of the TCS system ...................................... Page 24

7.6.5. Remote interlock connector for 405-nm laser (optional) ....................................................... Page 25

7.6.6. Safety beam guiding and beam shield at inverted microscope stands .................................. Page 26

7.6.7. Function and position of safety switches ............................................. Page 27

7.7. Which safety labels are used? ............................................. Page 28

7.7.1. On the upright microscope stand ..................................... Page 28

7.7.2. On the inverted microscope stand ..................................... Page 33

7.7.3. On the scan head .......................................................... Page 34

7.7.4. On the supply unit .......................................................... Page 36

7.7.5. On an external 405-nm diode laser (optional): ............................................. Page 37

7.8. Overview of usable lasers .................................................. Page 38

7.9. Which requirements are placed upon the installation/storage site for safety reasons? ................ Page 40

7.10. What must be observed when moving the installation site of a Leica laser scanning microscope? .................................................. Page 41

8. Confocal Imaging ................................................................. Page 42

8.1. What is confocal imaging? .................................................. Page 42

8.2. Optical resolution ............................................................. Page 43

8.3. Detection ................................................................. Page 43

8.4. Image processing ............................................................. Page 44

8.5. Light source ................................................................. Page 45

8.6. Integration ................................................................. Page 45

9. Starting-up the confocal system ................................. Page 46

10. Starting the Operating System ................................. Page 57

10.1. Setting Up Users ............................................................. Page 58
# Table of Contents

11. What is the Köhler illumination? ................................................. Page 59
   11.1. Setting the Köhler illumination ........................................ Page 60

12. Switching off the laser scanning microscope ............................... Page 63

13. Changing the Scanner to another Leica
    Microscope Stand ................................................................. Page 65

14. The Leica Confocal Software .................................................. Page 68
   14.1. Starting the Software ...................................................... Page 68
       14.1.1. Requirements for starting the software ....................... Page 68
       14.1.2. Starting the software ............................................. Page 68
       14.1.3. The Experiment Software Concept ............................... Page 69
       14.1.4. The Basic Structure of the User Interface .................... Page 69
   14.2. Opening and saving data sets ......................................... Page 71
       14.2.1. Readable File Formats ............................................ Page 71
       14.2.2. Automatically Applying the Study Parameters
               of an Experiment ................................................... Page 71
       14.2.3. Saving Images ..................................................... Page 72
       14.2.4. Data Organization by Grouping Experiments ................. Page 72
       14.2.5. Compiling Experiments ........................................... Page 72
   14.3. Keyboard Shortcuts ...................................................... Page 73
   14.4. Menu Functions ........................................................... Page 74
       14.4.1. File Menu ............................................................ Page 74
       14.4.2. The View Menu .................................................... Page 75
       14.4.3. The Macro Menu ................................................... Page 75
       14.4.4. The Tools Menu ................................................... Page 76
       14.4.5. The Window Menu ................................................ Page 77
       14.4.6. The Help Menu .................................................... Page 77
   14.5. LCS File Formats ........................................................ Page 78
       14.5.1. Formats of user-specific and device-dependent data ........ Page 78
       14.5.2. Fixed Leica-specific file formats ............................... Page 80

15. Specification of the "Lei" file format (version beta 2.000) ............. Page 81
   15.1. Structure of description file ........................................... Page 81
16. Introduction to the Leica Confocal Software Help ........ Page 93
  16.1. Quick Help .............................................................. Page 93
  16.2. Context-sensitive Help ............................................ Page 93
  16.3. Retrieving help topics using the table of contents .......... Page 94
  16.4. Retrieving help topics using a keyword ....................... Page 94
  16.5. Retrieving help topics using the full-text-search .......... Page 94
  16.6. Favorites ................................................................. Page 95
  16.7. Documentation Conventions ..................................... Page 95
  16.8. Performing a task ..................................................... Page 96

17. Help via the Internet ................................................. Page 97

18. Maintenance and Cleaning ......................................... Page 98
  18.1. Selecting an installation site ..................................... Page 98
  18.2. Cleaning the optical system of the microscope ............. Page 98
  18.3. Cleaning the microscope surface ................................ Page 99

19. Optional trigger control panel ................................. Page 100
  19.1. Description of Function .......................................... Page 100
  19.2. Installation ............................................................. Page 102
  19.3. Application ............................................................. Page 102

20. Declaration of Conformity ......................................... Page 103
1. General

1.1. About these operating instructions

These operating instructions direct their main area of concentration to the safety notes which must be strictly observed while working with the laser scanning microscope.

In addition, these operating instructions provide the user with a rough overview of the operating principle of laser scanning microscopes, present the first steps for activating and starting up the system and provide a description of the Leica Confocal Software.

The Leica TCS SP2 MP is supplied with the latest version of the licensed Leica Confocal Software. To always keep the information up to date, the description of software functions was intentionally omitted from these operating instructions. Instead, reference is made to the online help of the Leica Confocal Software which presents the most up-to-date explanations and instructions to the corresponding software functions.

First, read the chapter “Introduction to the Leica Confocal Software help” in these operating instructions to familiarize yourself with its design and operation. Additional information about particular functions can subsequently be viewed directly on the screen in electronic form.
2. Legal Notes

Made in Germany.

© Copyright 2001−2004, Leica Microsystems Heidelberg GmbH. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or storing in a retrieval system, or translating into any language in any form without the express written permission of Leica Microsystems Heidelberg GmbH.

DISCLOSURE

This document contains Leica Microsystems Heidelberg GmbH proprietary data and is provided solely to its customers for their express benefit of safe, efficient operation and maintenance of the product described herein. Use or disclosure of Leica Microsystems Heidelberg GmbH proprietary data for the purpose of manufacture or reproduction of the item described herein, or any similar item, is prohibited, and delivery of this document shall not constitute any license or implied authorization to do so.

REVISIONS AND CHANGES

Leica Microsystems Heidelberg GmbH reserves the right to revise this document and/or improve products described herein at any time without notice or obligation. Information and specifications in this manual are subject to change without notice.

WARRANTY

Leica Microsystems Heidelberg GmbH provides this publication "as is" without warranty of any kind, either expressed or implied, including but not limited to the implied warranties of merchantability or fitness for a particular purpose. All reasonable precautions have been taken in the preparation of this document, including both technical and non-technical proofing. Leica Microsystems Heidelberg GmbH assumes no responsibility for any errors or omissions. Leica Microsystems Heidelberg GmbH shall not be responsible for any direct, incidental or consequential damages arising from the use of any material contained in this document.

TRADEMARKS

Throughout this manual, trademarked names may be used. Rather than including a trademark (™) symbol at every occurrence of a trademarked name, we state that we are using the names only in an editorial fashion, and to the benefit of the trademark owner, with no intention of infringement.

SAFETY

The terms used of the laser safety class refer to the standard EN 60825-1. Within the scope of the CDRH, the laser class 4 should be replaced by IV in the text, the laser class 3B by IIIb, the laser class 3A by IIIA, the laser class 2 by II and the laser class 1 by I.

This instrument is designed and manufactured to comply with applicable performance standards for Class 3B laser products as defined by USHHS, CDRH/FDA, OSHA and EN standards and regulations known to be effective at the date of manufacture.
Every hazardous situation cannot be anticipated, therefore, the user must exercise care, common sense, and observe all appropriate safety precautions applicable to Class 3B lasers and high-voltage electrical equipment during installation, operation and maintenance.

Deviating from published operating or maintenance procedures is not recommended. Operation and maintenance procedure changes are performed entirely at the user’s risk.

SOFTWARE LICENSE

The software described in this document is furnished under a License Agreement which is included with the product. This agreement specifies the permitted and prohibited uses of the product.
3. Intended use/purpose

The system was designed for confocal recording (laser scanning images) of fluorescence-labelled living and fixed specimens as well as for quantitative measurements in the area of life science. This device was designed for use in a lab. Use for in-vitro diagnostics for medicinal purposes is not included in the intended use.

The manufacturer assumes no responsibility or liability for any use outside of the intended use or use outside of the specifications from Leica Microsystems Heidelberg GmbH or any risks resulting from such use. In such cases, the certificate of conformity is invalid.
4. Explanation of Document Symbols

Such a warning alerts you of an operating procedure, practice, condition, or statement that must be strictly observed to avoid death or serious injury to the persons working on the equipment.

Such a safety caution alerts you to an operating procedure, practice, condition, or statement that must be strictly observed to prevent equipment damage or destruction, or corruption or loss of data.

Notes are statements that either provide extra information about a topic or contain special instructions for handling a particular condition or set of circumstances.
5. Dimensions

5.1. Leica TCS SP2 MP System (direct coupling)
The maximally equipped configuration is shown. Standard configurations and options can be found on the individually applicable price lists.
5.2. Leica TCS SP2 MP System (fiber coupling)

The maximally equipped configuration is shown. Standard configurations and options can be found on the individually applicable price lists.
### 5.3. Technical Specifications and connection requirements for TCS SP2 MP

The Leica TCS SP2 MP is classified as Over-voltage Class II / Pollution Degree 2

<table>
<thead>
<tr>
<th>+MP</th>
<th>+Heat exchanger</th>
</tr>
</thead>
<tbody>
<tr>
<td>various laser combinations possible</td>
<td>(corresponding to the infrared laser system used)</td>
</tr>
<tr>
<td><strong>Electrical connection requirements</strong></td>
<td></td>
</tr>
<tr>
<td>230 V AC, 10 A, 50/60 Hz or</td>
<td>230 V AC, 5 A, 50/60 Hz or</td>
</tr>
<tr>
<td>110 V AC, 15 A, 50/60 Hz</td>
<td>110 V AC, 10 A, 50/60 Hz</td>
</tr>
<tr>
<td><strong>Dimensions LxWxH [mm]</strong></td>
<td></td>
</tr>
<tr>
<td>see individual, configuration-dependent installation diagrams</td>
<td>see individual, configuration-dependent installation diagrams</td>
</tr>
<tr>
<td><strong>Weight [kg]</strong></td>
<td></td>
</tr>
<tr>
<td>Mira/Verdi: 145</td>
<td>Mira/Verdi: 11</td>
</tr>
<tr>
<td>Tsunami/Millenium: 120</td>
<td>Tsunami/Millenium: 40</td>
</tr>
<tr>
<td>Mai Tai: 95</td>
<td>Mai Tai: 40</td>
</tr>
<tr>
<td>Optical bench: maximum 280</td>
<td></td>
</tr>
<tr>
<td><strong>Heat emission (system)/ Cooling power</strong></td>
<td></td>
</tr>
<tr>
<td>1.5 kW</td>
<td>1 kW</td>
</tr>
<tr>
<td><strong>Environmental/ climatic requirements</strong></td>
<td></td>
</tr>
<tr>
<td>optionally with pressurized air cushioning for vibration absorption</td>
<td></td>
</tr>
<tr>
<td><strong>Laser Class</strong></td>
<td>IIIb/4</td>
</tr>
</tbody>
</table>
6. Description of the multiphoton IR laser system

The Leica TCS SP2 MP multiphoton system consists of a Ti:Sa-Laser (Tsunami, MaiTai or MIRA type). The Ti:Sa-Laser itself is optically pumped by a frequency-doubled solid-state laser (Millenia or Verdi type). The pump laser itself is, in turn, optically pumped by a diode laser that is located in the solid-state laser’s power pack. The radiation generated by the diode laser is coupled to the solid-state laser. The radiation generated by the solid-state laser is led to the Ti:Sa laser through a safety beam conductor. With the exception of the laser power pack, the entire laser system is located on a vibration-proofed optical stage.

6.1. Specifications of the multiphoton IR laser system

Please refer to the corresponding manuals provided for specifications of the multiphoton laser system.

6.2. Details of the laser safety housing for the beam coupling

The following diagram shows the inner structure of the laser safety housing for the beam coupling between infrared laser system and microscope.

**Figure 1:** (1) Auto-correlator (optional), (2) Spectrometer, (3) Laser safety enclosure, (4) Laser safety shutter, (5) Optical fiber
6.3. Installation of the multiphoton IR laser system

Installation of the multiphoton IR laser system is performed directly by the manufacturer, or one of its official branches or agencies.

6.4. Laser system warranty

The warranty period for the multiphoton IR laser system is 1 year or 3,000 hours, whichever comes first (but a maximum of 15 months after delivery). The warranty period begins on the day of installation. The warranty includes replacement parts and travel costs. Not included: maintenance work, adjustment work, or exchange of consumable items such as fuses or mirrors (if the desired light wavelength generation is to be modified); damage through incorrect use, or import duties for replacement parts.

6.5. Service calls and product modifications

Service calls and product modifications within the warranty period are transacted by the laser manufacturer’s local branch offices. Direct product return shipments to the laser manufacturer should not be made without prior approval of the local branch. Serial numbers may not be altered or removed. The laser manufacturer’s products may not be modified. Exceptions are those alterations described in the multiphoton IR laser system’s operating manual.
7. General Safety Notes

7.1. Safety Notes for the User

- **Read and observe the safety notes in the Operating Instructions and the safety labels located on the instrument.**
  Failure to observe the safety notes may lead to serious injuries and to significant damages to the instrument and the data.

- **Observe the instructions for operating the instrument located in the Operating Instructions.**

- **Before performing certain operating steps using the instrument, always read the corresponding description of the function in the online help first.**
  You can get an overview of the single functions in the contents file of the online help.

- **Do not connect any external equipment.**
  Connect only those electrical devices to the product that are listed in the Operating Instructions. Otherwise, please contact your local Leica service agency or Leica Microsystems Heidelberg GmbH.

7.2. Which standards does this product meet?

This device was tested and meets the requirements of the following standards:

- IEC/EN 61010-1 "Safety requirements for electrical equipment for measurement, control and laboratory use"

- IEC/EN 61326 "Electrical equipment for measurement, control and laboratory use - EMC requirements" (Class A)

- IEC/EN 60825-1 "Safety of laser products, Part 1: Equipment classification, requirements and user’s guide"

- CDRH 21 CFR 1040.10: Laser Products
  U.S. Food and Drug Administration (FDA) ("Complies with FDA performance standards for laser products except for deviations pursuant to laser notice No. 50, dated 26 July, 2001.")
7.3. What should the user of the laser scanning microscope observe?

- The user of this product is responsible for proper and safe operation and safe maintenance of the device as well as for following all applicable safety regulations. The user is fully liable for all consequences resulting from the use of the device for any other purposes than those listed in the Operating Instructions or the online help.

- The user is required to perform and monitor suitable safety measures (according to IEC 60825-1 and the corresponding national regulations). Users must have received instructions concerning the risk potential associated with the operation of laser devices.

- To assure class 4 laser product and electrical safety compliance, all safety devices, interlocks, and safety systems of the laser device must be in operational condition. Deactivating or damaging these safety devices or any intervention in any of these safety devices may lead to serious eye injuries, physical injuries or property damages. In these cases, Leica Microsystems Heidelberg GmbH does not assume any liability.


- Repairs and service measures may only be performed by service technicians authorized by Leica Microsystems Heidelberg GmbH. The user is fully liable for all consequences resulting from the use of the device if it is opened, improperly serviced or repaired by other persons than authorized Leica customer service representatives.

- If repairs or service measures are performed that require opening parts of the housing, only trained Leica service technicians may occupy the room in which the laser scanning microscope is located.

Leica Microsystems Heidelberg GmbH will not be liable for damages resulting from nonobservance of the above information. The above information does not, in any way, implicitly or explicitly, modify the warranty and liability clauses contained in the general terms and conditions of Leica Microsystems Heidelberg GmbH.
7.4. Operational reliability

7.4.1. De-energizing the system

The main circuit breaker is located on the right side of the supply unit. It is used to de-energize the complete system using a single switch.

The main circuit breaker functions as a switch and as an overcurrent fuse.

This device is intended for service tasks or for emergencies.

It is not to be used as the regular on/off switch for the system.

Figure 1: Supply unit with main circuit breaker

7.4.2. Maximum current load of the power outlet strip at the supply unit

The total power consumption of all loads connected to the power outlet strip must not exceed 8 A.

Figure 2: Power outlet strip, rear side of supply unit
7.5. Laser safety

7.5.1. Which laser class does this product have?

According to IEC/EN 60825-1, this laser scanning microscope is a laser device of Class 4.

For the scope of the CDRH/FDA (USA), the designation Laser Class 4 in the text must be replaced by IV.
7.5.2. Safety notes for operating the laser scanning microscope

During scanning, the laser radiation is freely accessible after exiting the objective in the specimen area of the laser scanning microscope. This circumstance demands special attention and caution. If the laser radiation comes in contact with the eyes, it may cause serious eye injuries. For this reason, prudent handling is absolutely necessary as soon as one or several laser emission warning indicators are lit.
If used as prescribed and observing the safety notes during the operation of a laser scanning microscope, there are no dangers to the user.

- Never look directly into a laser beam or a reflection of the laser beam. Avoid all contact with the laser beam. Otherwise, your eyesight may be permanently damaged. A reflected laser beam is just as dangerous as a direct beam.

- Never deactivate the laser protection devices. Read the chapter “What are the safety devices of the laser scanning microscope?” to familiarize yourself with the safety devices of the laser scanning microscope.

- Note that objects (such as micromanipulators) in the specimen area may cause laser light to exit the safe beam path during the scanning in an uncontrolled manner by means of reflection or scattering and endanger the environment.

- Do not change a specimen during scanning.

Procedure

<table>
<thead>
<tr>
<th>Upright microscope</th>
<th>Inverted microscope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch off the lasers.</td>
<td>Switch off the lasers.</td>
</tr>
<tr>
<td></td>
<td>Tilt the transmitted-light arm back.</td>
</tr>
<tr>
<td>Exchange the specimen. Insert the specimen</td>
<td>Exchange the specimen. Insert the speci-</td>
</tr>
<tr>
<td>men correctly into the specimen holder.</td>
<td>men correctly into the specimen holder.</td>
</tr>
<tr>
<td></td>
<td>Tilt the transmitted-light arm back into</td>
</tr>
<tr>
<td></td>
<td>the working position.</td>
</tr>
</tbody>
</table>
- Do not change any objectives during scanning.

**Procedure**

- Switch off the lasers.
- Rotate the objective turret so that the objective to be changed is swiveled out of the beam path and points outward.
- Exchange the objective.
- All unoccupied positions in the objective turret must be closed using the supplied caps.

- Close all unused positions of the objective turret with a cap.

- Do not change any filter cubes or beam splitters during scanning.

**Procedure**

<table>
<thead>
<tr>
<th>Upright microscope</th>
<th>Inverted microscope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch off the lasers.</td>
<td>Switch off the lasers.</td>
</tr>
<tr>
<td>Remove the cover of the fluorescence mo-</td>
<td>Pull out the fluorescence module.</td>
</tr>
<tr>
<td>dule (see Microscope Stand operating in-</td>
<td></td>
</tr>
<tr>
<td>structions).</td>
<td></td>
</tr>
<tr>
<td>Remove the filter cube/beam splitter.</td>
<td>Remove the filter cube/beam splitter.</td>
</tr>
<tr>
<td>Insert the desired filter cube/beam splitter.</td>
<td>Insert the desired filter cube/beam splitter.</td>
</tr>
<tr>
<td>Reattach the cover to the front of the flu-</td>
<td>Reinsert the fluorescence module.</td>
</tr>
<tr>
<td>losecence module.</td>
<td></td>
</tr>
</tbody>
</table>

- Never disconnect an optical waveguide.

- Never remove the scan head from the microscope stand during operation.
  Before removing the scan head, the system must be completely switched off.

- Do not use an S70 microscope condenser.
  The large working distance and the low numeric aperture of the S70 microscope condensers could result in a threat from laser radiation.
  Therefore, only S1 and S23 Leica microscope condensers should be used.
7.5.3. Transmitted light lamp housing at upright stands

- **Upright stand without transmitted light lamp housing**

  If there is no transmitted light lamp housing connected to the upright stand, it is necessary to close the opening with the enclosed cover in order to prevent the emission of laser radiation.

- **Upright stand with transmitted light lamp housing**

  If there is a transmitted light lamp housing connected to the upright stand and you want to replace it, proceed as follows:

  - Switch off the lasers.
  - Disconnect the lamp housing from the power supply.
  - Remove the lamp housing.
  - Perform the intended tasks at the lamp housing.
  - After finishing the tasks, screw the lamp housing back onto the microscope stand.

**Figure 3: Connecting the transmitted light lamp housing**

During the time when no lamp housing is connected to the microscope stand, the lasers must not be switched on since laser radiation could otherwise exit from the opening in the microscope stand.
7.5.4. Eye protection

System with inverted microscope stand:
It is not necessary to wear eye protection. If the device is used as prescribed and the safety notes are observed, the limit of the laser radiation is maintained so that eyes are not endangered.

System with upright microscope stand:
The laser beam can be deflected or scattered by the specimen or objects moved into the specimen area. For this reason, a danger to the eyes cannot be ruled out in any case. Using protective eyewear (specification: 680-990 DIR L5 / 990-1064 DIR L4) is required. Corresponding eye protection is included in the delivered system. **The supplied eye protection only provides safe protection against the infrared lasers supplied by Leica Microsystems Heidelberg GmbH.**
7.6. What laser safety devices does the laser scanning microscope have?

7.6.1. Shielding

The light of all employed VIS lasers (wavelength range 400-700 nm, visible spectrum) and UV lasers (wavelength range < 400 nm, invisible) is fed through an optical waveguide and, therefore, completely shielded until it leaves the microscope objective and reaches the specimen.

For systems with infrared laser (wavelength > 700 nm), the beam is passed through a safety beam guiding and, if necessary, also passed through an optical waveguide. This shields the laser beam and makes it inaccessible to the user until it leaves the microscope objective and reaches the specimen.

Figure 4: (1) Safety beam guiding (2) IR laser
7.6.2. Detachable-key switch

The detachable-key switches for protection against unauthorized use of the laser devices are located on the control panel.

Figure 5: Detachable-key switch for internal laser

In the case of an optional external 405-nm laser, the detachable-key switch for the laser is located on its power pack.

Figure 6: Detachable-key switch of the optional external 405-nm laser

For lasers that are not connected as described above, please refer to the supplied manual of the laser manufacturer for the position of the detachable-key switches.
7.6.3. Emissions warning indicators

The readiness of the laser is signaled by an emission warning indicator. The emission warning indicators are located above the detachable-key switches and are yellow when lit. As soon as the emission warning indicator of the laser is lit, it is possible from a functional standpoint that laser radiation is present in the specimen area.

Figure 7: Emission warning indicators on the control panel

The optional 405-nm laser features the emission warning indicator (1) above the detachable-key switch.

Figure 8: Emission warning indicator on the optional external 405-nm laser

For lasers whose readiness is not indicated as described above, please refer to the supplied manual of the laser manufacturer for the location of the emission warning indicator.
7.6.4. Remote interlock connector on the supply unit of the TCS system

The remote interlock connection is located on the rear side of the supply unit (15 VDC supply voltage). The remote interlock connector is plugged into this connection.

The remote interlock connector features a shorting bridge that jumpers Pin 1 and Pin 5 as shown in the following illustration.

Remote interlocks that are connected to the room, the door or other locally fixed safety interlocks can be connected to the remote interlock connection.

The laser beam path is interrupted if the contact is open.

The overall length of the cable between the two connecting pins of the remote interlock connector should not exceed 10 m.

Figure 9: Wiring of the remote interlock connector on the rear side of the supply unit
7.6.5. Remote interlock connector for 405-nm laser (optional)

If the laser scanning microscope is equipped with the optional 405-nm laser (non-pulsed), the "Interlock" remote interlock connection is located on the rear side of the laser power supply.

The remote interlock connector contains a shorting bridge.

Remote interlocks that are connected to the room, the door or other locally fixed safety interlocks can be connected to the remote interlock connection.

The laser beam path is interrupted if the contact is open.

Figure 10: Wiring of the remote interlock connector on the rear side of the laser power supply

The supply voltage of the remote interlock circuit of the 405-nm laser is 230 VAC.

For this reason, the remote interlock circuit of the 405-nm laser must never be connected to other remote interlock circuits but, instead, must be securely separated from them.

Due to the live voltage of 230 V, replacing the shorting plug by an external interrupt circuit (e.g. door interlock switch) may only be performed by a qualified electrician.
7.6.6. Safety beam guiding and beam shield at inverted microscope stands

The safety beam guiding and beam shield are used with inverted microscopes to protect against laser radiation and are located between condenser and transmitted-light detector.

Figure 11: (1) Safety beam guiding, (2) Beam shield
7.6.7. Function and position of safety switches

When the safety switches are released, the light path of the laser beam is interrupted.

Figure 12: Position of the safety switch on the upright am microscope stand (left) and on the inverted microscope stand (right)

<table>
<thead>
<tr>
<th>Position</th>
<th>Activated by:</th>
<th>Type of microscope</th>
<th>Activated if:</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Switching lever at the beam splitter in the tube of the microscope</td>
<td>Upright (DMR, DML FS)</td>
<td>An integrated beam splitter prism is moved into the beam path of the microscope.</td>
<td>Prevents stray light if the user switches from confocal observation to eyepiece observation.</td>
</tr>
<tr>
<td>2</td>
<td>Switching lever at the beam splitter in the tube of the microscope</td>
<td>Inverted (DMIR)</td>
<td>An integrated beam splitter prism is moved into the beam path of the microscope.</td>
<td>Prevents stray light if the user switches from confocal observation to eyepiece observation.</td>
</tr>
<tr>
<td>3</td>
<td>Transmitted-light illuminator arm</td>
<td>Inverted (DMIR)</td>
<td>The illuminator arm is tilted (e.g. for working on the specimen)</td>
<td>Prevents laser light while working on the specimen.</td>
</tr>
</tbody>
</table>
7.7. Which safety labels are used?

The corresponding safety labels are selected dependent on the laser configuration (VIS, UV, MP) and attached in the following locations.

7.7.1. On the upright microscope stand

![Safety label on the stand of the DM Rxxx product series (left)]
Figure 14: Safety label on the stand of the DM Rxxx product series (right)
Figure 15: Safety label on the stand of the DM LFSxxx product series
Figure 16: Safety label on the stand of the DM 6000 product series (front side)
Figure 17: Safety label on the stand of the DM 6000 product series (rear side)
7.7.2. On the inverted microscope stand

Figure 18: Safety label on the stand of the DM IRxxx product series
7.7.3. On the scan head

Figure 19: Safety label on the scan head (left)
Figure 20: Safety label on the scan head (right)
7.7.4. On the supply unit

Figure 21: Safety label on the supply unit
7.7.5. On an external 405-nm diode laser (optional):

Figure 22: Safety label on an external 405-nm laser
### 7.8. Overview of usable lasers

The laser scanning microscope features a combination of the lasers listed below.

<table>
<thead>
<tr>
<th>Laser type</th>
<th>Wavelength [nm]</th>
<th>Maximum luminous power at laser output [mW]</th>
<th>Maximum luminous power in focal plane [mW]</th>
<th>Pulse duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ar-UV</td>
<td>351, 364</td>
<td>&lt; 60</td>
<td>&lt; 4</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Diode</td>
<td>405</td>
<td>&lt; 25</td>
<td>&lt; 3</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Diode</td>
<td>405</td>
<td>&lt; 5</td>
<td>&lt; 0.3 (mean power)</td>
<td>pulsed, 60 ps</td>
</tr>
<tr>
<td>Solid state</td>
<td>430</td>
<td>&lt; 10</td>
<td>&lt; 4</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>HeCd</td>
<td>442</td>
<td>&lt; 30</td>
<td>&lt; 3</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>DPSS442</td>
<td>442</td>
<td>&lt; 12</td>
<td>&lt; 3</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>ArKr</td>
<td>488, 568, 647</td>
<td>&lt; 125</td>
<td>&lt; 25</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Ar</td>
<td>458, 476, 488, 496, 514</td>
<td>&lt; 200</td>
<td>&lt; 30</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Ar, external</td>
<td>458, 476, 488, 496, 514</td>
<td>&lt; 500</td>
<td>&lt; 125</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>HeNe</td>
<td>543</td>
<td>&lt; 1.5</td>
<td>&lt; 0.5</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>DPSS561</td>
<td>561</td>
<td>&lt; 12</td>
<td>&lt; 4</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Kr</td>
<td>568</td>
<td>&lt; 40</td>
<td>&lt; 8</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>HeNe</td>
<td>594</td>
<td>&lt; 4</td>
<td>&lt; 1</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>Laser Type</td>
<td>Wavelength</td>
<td>Laser Power (A)</td>
<td>Power (W)</td>
<td>Power (dBm)</td>
</tr>
<tr>
<td>------------</td>
<td>------------</td>
<td>-----------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>HeNe</td>
<td>633</td>
<td>&lt; 15</td>
<td>&lt; 4</td>
<td>Continuous wave, non-pulsed</td>
</tr>
<tr>
<td>TiSa</td>
<td>700-1000</td>
<td>&lt; 2000</td>
<td>&lt; 500 (mean power)</td>
<td>pulsed, 1.3 ps</td>
</tr>
</tbody>
</table>
7.9. Which requirements are placed upon the installation/storage site for safety reasons?

The limits concerning the emission of electromagnetic radiation (EMC) are met by this device to EN 61326. A residual risk of affecting other devices cannot be ruled out.

⚠️ This device was designed for use in a lab and may not be set up in an area with medical devices serving as life-support systems.

⚠️ This equipment is designed for connection to a grounded (earthed) outlet. The grounding type plug is an important safety feature. To reduce the risk of electrical shock or damage to the instrument, do not disable this feature.

⚠️ To reduce the risk of fire hazard and electrical shock, do not expose the unit to rain or humidity. Do not open the cabinet. Do not allow any liquid to enter the instrument cabinet, or come into contact with any electrical components. The instrument must be thoroughly dry before connecting it to the power supply or turning it on.
7.10. What must be observed when moving the installation site of a Leica laser scanning microscope?

Before moving the laser scanning microscope, it should be thoroughly cleaned. The same also applies to the removal of components. This applies in particular to systems that are located in biomedical research labs.

This is necessary to remove a possible contamination and, thereby, avoid carry-over of dangerous substances and pathogens and its accompanying risk of persons.

Pay not only attention to surfaces, but especially to fans and cooling devices since dust can frequently accumulate at these locations.
8. Confocal Imaging

8.1. What is confocal imaging?

Conceptualized in 1953, the Confocal Laser Scanning Microscopy has only in the past 10 years become a practical technique. Today it is the technique of choice for biological research, chemical analysis, and materials testing. The results of many years of research and development in many different areas are combined in such an instrument: microscopy, laser technology and optics for coherent light, video technology, electronics and computer technology.

Confocal microscopy detects structures by collecting light from a single focal plane of the sample, excluding light that is out of focus.

In a point scanning confocal system, the microscope lenses focus the laser light on one point in the specimen at a time (the focal point). The laser moves rapidly from point to point to produce the scanned image. Both fluorescent and reflected light from the specimen pass back through the objective.

The microscope and the optics of the scanner module focus the light emitted from the focal point to a second point, called the confocal point. The pinhole aperture, located at the confocal point, allows light from the focal point to pass through the detector. Light emitted from outside the focal point is rejected by the aperture.

The confocal principle is illustrated schematically for the epi-illumination imaging mode.

As in conventional epifluorescent microscopes, one lens is used as both condenser and objective. The advantage is eliminating the need for exact matching and co-orientation of two lenses. A collimated, polarized laser beam from an aperture is reflected by a beam splitter (dichroic mirror) into the rear of the objective lens and is focused on the specimen. The reflected light returning from the specimen passes back through the same lens. The light beam is focused into a small pinhole (i.e., the confocal aperture) to eliminate all the out-of-focus light, i.e., all light coming from regions of the specimen above or below the plane of focus. The achieved optical section thickness depends on several parameters such as the variable pinhole diameter and the wavelength. The in-focus information of each specimen point is recorded by a light-sensitive detector (e.g., a photodiode) positioned behind the confocal aperture. The analog output signal is digitized and fed into a computer.

The detector is a point detector and only receives light from one point in the specimen. Thus, the microscope sees only one point of the specimen at a time as opposed to the conventional microscope where an extended field of the specimen is visible at one moment. Therefore, to obtain an image it is necessary either to move the illuminated point or to move the specimen. These two possibilities have given rise to two different types of confocal microscopes:

Microscopes with movable objective stage (stage scanning): The objective stage with the specimen is moved forward after every finished recording, while the optical system remains stationary with this type of scanning.
Microscopes with beam or mirror technology: The illuminated point is scanned over the fixed specimen using small, fast, galvanometer-driven mirrors as used by LEICA.

The LEICA TCS SP2 MP system allows you to image a single focal plane as well as a series of planes—horizontal or vertical. A single vertical section or xz-scan allows for a side view of the specimen.

If a sequence of optical sections of the specimen is combined to form an image stack and then digitally processed, it offers the advantage of using this multidimensional data set to create either a calculated two-dimensional image (projection) or a reduced scale 3D representation of the specimen using a suitable computer.

### 8.2. Optical resolution

The term resolution refers to the capability of distinguishing finest details in a structure. In a perfect microscope, the optical system would be free of any type of aberration. In such a hypothetical instrument, the resolution would be limited only through diffraction. One could express this as the smallest distance between two points of a specimen at which they are still visible as two separate points (Rayleigh criterion). Beyond this limit, the two points merge (i.e., their diffraction discs overlap completely or partially) and can no longer be recognized as two different points. This distance can be calculated using the size of the diffraction image of an infinitely small point of the specimen. It corresponds to the radius of the first minimum in this diffraction image. This, in turn, is related to the numeric apertures of the objective and the condenser. The numeric aperture is defined by the diffraction index of the lens and the size of the luminous cone that may enter.

Analogous to the argumentation above, the axial resolution can be defined as the radius of the first minimum along the microscope axis of the diffraction image of a point object. According to the theory for such 3D diffraction images, the optical resolution along the z-axis is smaller than the lateral optical resolution by a factor of 2. Thus, the optical resolution along the z-axis amounts to approximately one half of the resolution within the focal plane.

The LEICA TCS SP2 MP microscope is a no-compromise true point-scanning system with extremely high sensitivity and theoretical maximum x-, y- and z-resolution.

Scan resolution refers to image clarity as determined by the number of pixels and pixel size. The larger the number of pixels and the larger the scanning format, the more easily two close objects can be distinguished. The scan resolution is restricted to the maximum optical resolution power.

### 8.3. Detection

Confocal imaging, or to be more precise, the measurement of the optical properties of tiny sub-volumes of a specimen, is limited not only by the optical quality of the microscope. Other limitations are:

- The measurement of continuous specimen only in discrete sub-volumes (because of sampling and digitalization).
- The accuracy with which the sub-volumes are defined, determined by the scanning mechanism.
- The brightness of the light source in relation to the reflectivity of the specimen.
- The sensitivity and noise produced by the detector.

Another central component of the confocal microscope is the detector. Due to its very high signal-to-noise ratio, LEICA Microsystems Heidelberg uses photomultipliers as detectors.

### 8.4. Image processing

In the first confocal microscopes, the detector was connected to an oscilloscope with long-persistence phosphor which would display an image as it was being scanned. In the instruments of today, the signal is digitized and recorded in a computer. This makes it possible to manipulate the image in a multitude of ways. The following options are available:

- Contrast enhancement by thresholds, linear contrast stretching and gamma correction (curvature of the image intensity value versus source intensity graph).
- Superimposition of images in experiments.
- Digital filtering for edge enhancement, smoothing, noise suppression, etc.
- Reconstruction of three-dimensional views from stacks of images of optical sections. This allows, for instance, an image of an xz plane to be reconstructed from a stack of images of xy planes. Complete 3D models of the specimen can also be rendered and examined from any direction.
- Assembly of digital movies from time-sequences of microscope images.
- Quantification and Measurements.

Although this type of image manipulation does not improve the quality of the collected data, it serves the purpose of improving the visibility and facilitating the qualitative interpretation of the data.
8.5. Light source

Lasers are extremely well suited as light sources for confocal microscopy because they emit a very bright light and small divergence of the beam. In addition, they are easy to focus and stable in intensity. The stability is especially important for quantitative measurements.

8.6. Integration

The Leica TCS SP2 MP was designed as an integrated system. Optical and mechanical elements work seamlessly with computer hardware and software. The integrated Leica Confocal Software package supports the complete imaging process, from optical sectioning, through image processing and analysis (which is the main application), to hardcopy output.


### 9. Starting-up the confocal system

1. Check whether the hardware dongle is plugged into the parallel port of the computer.
   
   The LCS software can NOT be started without the provided dongle.

2. Switch on the microscope(s) and the light sources.
   
   All manual Leica microscope stands (DM-LM, DM-IRB, DM-R, DM-LFSE) can be switched on and off using the switch located at the side of the stand.

   All automatic Leica microscope stands (DM-LFSA, DM-RXA, DM-RXA2, DM-RE, DM-IRBE) can be switched on and off using the switch located at the side of the stand.

   The Leica microscope stands DM-LFSA, DM-IRE2 and DM-RXA2 can be switched on and off using the separate electronics unit (LEICA CTR MIC Electronics box).

   All fluorescent lamps are equipped with individual power supplies. For this reason, they can only be switched on and off at the power supply.

3. Activate the switches on the control panel for the workstation (PC), confocal scanner (Scanner) and lasers (Lasers).

4. Log on to the computer.

   Use your personal user ID if one has been set up. This ensures that the user-specific settings are saved and maintained for this user only. If the system administrator has not yet assigned a personal user ID, log on as "TCS_User". A password is not required.
5. Start the LCS program.
   To do so, click on the program icon on the desktop of the computer.

6. Next, select a software profile. A separate profile can be created for each user containing the structure of the graphic user interface as well as the definition of user-specific settings of the confocal system.

   Do not perform the next step until the initialization of the hardware components is complete.

7. Affix a specimen and adjust the specimen using the conventional microscopy mode.
   First, focus on a position of your specimen to be observed. Next, set the Köhler illumination (see the chapter on "Köhler Illumination").
Adjusting to conventional observation for upright microscopes of series DM-Rxxx, DM-LFxx

- Turn the fluorescence filter dial to the appropriate filter cube (Figure/Pos. 1).
  1: DAPI (optional)
  2: TRITC
  3: FITC
  4: empty position (scan)
- Set the control bar to "VIS" (Figure/Pos. 2).

Figure 23: DM_Rxx microscopes (left), DM-LFSx microscopes (right)
Adjusting to conventional observation for inverted microscopes of series DM-IRxx

- Turn the fluorescence filter dial to the appropriate filter cube (figure/pos. 1).
  1: DAPI (optional)
  2: TRITC
  3: FITC
  4: empty position (scan)
- Pull the control bar out completely (removes additional filters from the beam path) (figure/pos. 2).
- Set the tube lens selector to the "scan"position (VIS stands) (figure/pos. 3).
- Insert the control bar for the beam splitter (side exit) completely ("off" position) (figure/pos. 4).
- Insert the control bar for the beam splitter (front exit) completely ("off" position) (figure/pos. 5).

Figure 24: DM_IRxx microscopes
8. Changing to confocal operation.

Switching to confocal observation for upright microscopes of the DM-Rxxx, DM-LFxx series

- Turn the fluorescence filter dial to the "Scan" position (Figure/Pos. 1).
- Pull out the control bar completely (position "TCS") (figure/pos.2).

Figure 25: DM_Rxx microscopes

- Turn the fluorescence filter dial to the position "4" (figure/pos. 1).
- Pull out the control bar completely (position "TCS") (figure/pos.2).

Figure 26: DM-LFSx microscope line
Adjusting to confocal observation for inverted microscopes of series DM-IRxx

- Turn the fluorescence filter dial to the "Scan" position (figure/pos. 1).
- Insert the control bar completely (position "Stop") (figure/pos. 2).
- Turn the tube lens selector to the "Scan" position (figure/pos. 3).
- Pull out the control bar for the beam splitter (side exit ) completely ("on" position) (figure/pos. 4).
- Insert the control bar for the beam splitter (front exit ) completely ("off" position) (figure/pos. 5).

Figure 27: DM_IRxx microscopes
9. Selecting a specific set of acquisition parameters (application).

- Press the "Beam" button in the "Acquire" operating step.

- Select a method in the open "Beam Path Setting" dialog window (top right window)

A method is a set of hardware settings (IPS: Instrument Parameter Setting) specifically identifying a certain acquisition technique and a special type of sample preparation. For example, the FITC/TRITC designation refers to the settings for a two-channel recording (simultaneous) for the two fluorescent dyes FITC and TRITC. It is always possible to define and store your own methods in addition to the factory-set methods. For details, refer to the chapter on "Software User Configurations".
10. Selecting the microscope objective.

- Press the "Obj." button in the "Acquire" operating step.
- Select the objective lens to be used in the opened dialog window.

With automatic microscope stands, the selected microscope objective is automatically moved into the beam path. Other stands require a manual operation.

11. Selecting the scan mode.

- Press the "Mode" button to select the scan mode.

The scan mode is used to select the type of data stack to be recorded. The following options are available:

- spatial scan mode (xyz, xzy)
- time scan mode (xt, xyt, xzt, xyzt)
- spectral scan mode (xyλ, xzλ).
12. Selecting the scan format.

- Press the "Format" button to select the scan format.

The scan format determines the number of grid points used by the scanner to scan the scan area.

13. Optimizing the acquisition parameters in continuous scan.

- Press the "Continuous" button to start the continuous scan. As soon as the continuous scan runs, you can use the control panel and its defined acquisition parameters to optimize image quality.

The optimization parameters include:
- the exact z-position within the specimen
- the amplification factor of the selected detector
- the diameter of the detection pinhole
- the zoom factor.
14. Acquisition of a three-dimensional spatial data set (3D series).

Define the upper limit of the data set to be acquired.

Use the corresponding knob for adjusting the z-position of the control panel.

The default setting of the z-position is position 7 of the control panel.

---

**Figure 28:** Standard layout of the control panel (bottom part of the image)

- Press the “Begin” button to define the starting position of the 3D series.
- Define the lower limit of the data set to be acquired. Use the corresponding knob for adjusting the z-position of the control panel.
- Press the “End” button to define the end position of the 3D series.
- Stop the continuous scan by pressing the "Cont." button again.
- Press the “Sect.” button to define the number of optical sections.

Additional details concerning this function can be found in the online help.

- Press the “Aver.” button to define the number of sampling times (frame average).

This method averages the recordings of individual optical sections.
15. Saving image data.

From the menu, select **File>Save as** to save the data record.

For additional details on saving data records and on saving formats, see the chapter entitled, "Opening and Saving Data Records".

- Next, press the “Series” button to record the 3D series.
10. Starting the Operating System

You do not have to start the operating system—it starts automatically when you turn on your PC. You will first see a splash screen.

1. Next you have to log on to your computer. As you can see from the instructions in the box, pressing the Ctrl, Alt and Delete keys at the same time will log you on. After pressing the Ctrl, Alt, and Delete keys, the Logon information dialog box appears.

2. Typing your password identifies you as a valid user for this computer.
   The default user name for the Leica TCS SP2 system is "TCS_User."
   A standard password was not set. It is recommended setting up a separate user ID for each user (system administrator). This will create individual directories that can be viewed only by the respective user. Since the LCS software is based on the user administration of the operating system, separate files are created for managing user-specific profiles of the LCS software. For information about setting up users, please refer to the chapter "Setting Up Users" in this manual.

3. After logging on with your user ID, you may change your password by pressing the keys Ctrl, Alt, and Delete at the same time.

4. Then click on Change Password. The Change Password dialog box displays.

5. Type your current password in the Old Password field (passwords are case sensitive, so be sure you use the right case).

6. Then press the Tab key. Pressing the Tab key moves the cursor to the next field.

7. Type your new password, then press the Tab key again. Confirm your new password by re-entering it. This will eliminate any typing errors. This is especially important since the characters you type appear as asterisks on the screen.

8. Then click the OK button. Your new password will be in effect the next time you log on.
10.1. Setting Up Users

1. Logging on as Administrator
   To log on as administrator use the ID: "Administrator" and the password:"Admin"

2. Open the User Manager.
   Select Start/Programs/Administrative Tools/User Manager.

3. Defining a new user.
   Enter the following information in the dialog window being displayed:
   - Username
   - Password (must be re-entered in the next line for confirmation purposes)

4. From the check boxes displayed, select the following two:
   a.) "User must change password at next logon" (this allows the new user to define his or her own password at logon)
   b.) "Password never expires" (this allows a defined password to be valid either until it is changed in the User Manager or the user is deleted)

5. Select the "Profiles" option in the bottom section of the dialog. In the "Local path" field enter the following path for storing user-specific files: d:\users\username ("username" is an open parameter which must be replaced by the currently defined user name).

   Factory-installed hard disks are set up with two partitions (C:\ and D:\). The user directory should be set up on partition D:\.
11. What is the Köhler illumination?

In a microscopic image, only a certain area of a specimen can be displayed (image field). Köhler illumination allows for illuminating only this particular area. The technical background for the illumination of the image field is described as follows:

If the illuminated area is smaller than the image field, the luminous cone detected by the objective lens as well as the numeric aperture becomes smaller. Since the optic resolution is directly dependent upon the numeric aperture, a lower illumination also reduces the optic resolution—which is not desired in most cases.

If the illuminated area is larger than the image field, it leads to increased scattered light. This, in turn, leads to a reduction of the image contrast, possibly resulting in the situation where optically dissolved structures of the microscopic image can no longer be observed.

Köhler illumination represents a compromise between maximum contrast and maximum resolution. The most efficient microscope objectives frequently reach their optimum optic performance only with exactly adjusted Köhler illumination.
11.1. Setting the Köhler illumination

1. **Focussing**
   Focus an area of the object. Neglect the quality of the illumination for the time being.

2. **Opening the aperture diaphragm**
   Fully open the aperture diaphragm. It will be closed at a later point in time until the desired contrast is adjusted.

![Figure 29: DM-Rxx (left) / DM-IRxx (right)](image)

![Figure 30: DM LFS/ LSFA](image)
3. **Closing the field diaphragm**

The image field darkens in most areas. You will see an unfocused light spot. If the spot disappears upon closing the field diaphragm, the field diaphragm must be centered. In this case, open the field diaphragm until you can just see the light spot at the border of the image field.

If no light spot is visible, the condenser could be set to the wrong height. You should, therefore, adjust the height of the condenser until the field diaphragm is visible.

4. **Focussing**

Focus the border of the light spot by adjusting the height of the condenser.

5. **Centering**

Turn the centering screws of the condenser until the light spot is centered in the middle of the image field. The centering is easier if you slightly open the field diaphragm to enlarge the light spot.

6. **Opening the field diaphragm**

Open the field diaphragm until the light spot just disappears at the border of the image field.

7. **Closing the aperture diaphragm**

Close the aperture diaphragm until you have set the desired image contrast (open to approximately 70% of the maximum diameter).

8. **If you change the objective**

It may become necessary to readjust the Köhler illumination after you have changed the objective.
12. Switching off the laser scanning microscope

1. Save the image data.
   From the menu, select File / Save as to save the data record.

2. Close the LCS Software.
   From the menu bar, select File / Exit to exit the LCS software.

3. On the control panel, turn off the switches for the scanner and the laser.

4. Shut down the computer.
   From the toolbar, select Start / Shutdown to shut down the computer.

5. Switch off the microscope and any fluorescent lamps that are switched on.

Figure 31: Shutting down the computer
13. Changing the Scanner to another Leica Microscope Stand

1. Switch off the system completely.

2. Remove the cable connector for the laser safety switch from the microscope tube. See step (1) in the following illustration.

3. Remove the RS 232 cable from the plug on the rear side of the microscope. See step (3) in the following illustration.
4. Loosen the Allen (hexagon) screw between the scanner and tube. See step (2) in the following illustration. To do so, use a 3mm metric Allen screw.

For microscopes equipped with separate electronic control units (LEICA CTR MIC electronics box), the RS 232 cable should not be removed from the microscope stand, but instead from the electronic control unit.

5. Carefully pull the scan head back and off.

The scan head weighs approx. 13 kg. Handle the scan head very carefully in order to prevent damage during the changing process.

6. Set the scanning head onto the new microscope stand as shown in the following figure.

7. Rotate the scan head 90 degrees and place it on to the tube optics in the direction of the arrow (1).
8. Fasten the scan head with the Allen screw. See (2) in the illustration above.

9. Insert the RS 232 plug into the rear side of the microscope. See (3) in the above illustration.

For microscopes equipped with separate electronic control units (LEICA CTR MIC electronics box), the RS 232 cable should not be removed from the microscope stand, but instead from the electronic control unit.
14. The Leica Confocal Software

14.1. Starting the Software

14.1.1. Requirements for starting the software

The LCS software is copy-protected to prevent it from being used on two computers at the same time. This protection system allows all additional application packages to be used. The protection system consists of a dongle that must be inserted into the parallel port of the workstation. The functionality of the parallel port (e.g., for printing, etc.) is not affected. To use the software on a second computer, the dongle must be attached to its parallel port.

If you remove the dongle from the workstation of the confocal system, the software cannot be started, thereby preventing operation of the confocal system.

The LCS software can be started in two operating modes: hardware mode and simulation mode. In hardware mode, all hardware components are accessed and initialized by the software. For this reason, you should switch on the hardware first and then wait about 20 seconds before starting the software.

In simulation mode, the software runs independently of the hardware. This mode is intended for secondary installations on another computer, for example for training or offline analysis of existing data.

14.1.2. Starting the software

Select Start / Programs / Leica Confocal Software.

The initial screen of the Leica Confocal Software appears. This window allows you to select from three profiles.

- **Company**
  This option starts the Leica Confocal Software using the default factory settings. This means that the configuration and the position of the Toolbars is preset. These settings cannot be changed.

- **Personal**
  This option lets you use a user-defined configuration profile. The user name is dependent upon the account used to log on to the operating system. If the custom profile does not yet exist at the first initialization, the default factory settings are applied to the personal profile.

- **Last Exit**
  This option loads the configuration profile that was last active.
For advanced users:

If you have more than one configuration profile, you can load them at startup by clicking the button with the three black dots, which is located at the right lower edge of the profile options. You may also use this option to reset your custom configuration profile to the standard factory profile.

Clicking the Start button starts the Leica Confocal Software using the corresponding configuration profile.

After a delay, the software starts automatically and loads the currently selected configuration profile.

14.1.3. The Experiment Software Concept

The Leica Confocal Software allows you to join image data or edited images into groups. Each group is called an "experiment" and is stored in a special data format (*.lei). This makes it possible to store both the original experimental image data and the image viewing data together.

Additional information can be found in the chapter "Organizing Data by Grouping Experiments".

14.1.4. The Basic Structure of the User Interface

The appearance of the Graphical User Interface—henceforth referred to as GUI—depends strongly on the configuration profile being used. A number of elements of the GUI, however, are standard.

The GUI provides the following standard elements:

- **The Menu**
  The menu contains the submenus File, View, Macro, Tools, Window and Help. The submenus contain commands and information for general display, settings and user customization. They do not provide any of the functions for directly controlling the scan functions. These functions are located in the TCS menu (View/Menu/TCS Menu). The menu line cannot be customized.

- **The Viewer Window (TCS_Viewer)**
  The Viewer window displays the image data, experimental conditions and user data. The image window can be configured (see the chapter on "Modifying the User Interface and Defining User-Specific Settings"). The image window shows not only the confocal image data records, but also the experiment data and system settings. You can open a new experiment image window by selecting File / New.

- **TCS Menu (TCS_Menu)**
  The TCS menu contains buttons for the individual device functions. It is subdivided into individual work steps. The number of work steps available depends on the installed soft-
The standard set of operating steps consists of data recording (Acquire), image viewing (View), surface reconstruction (3-D), measurement functions (Quantify), image processing and analysis functions (Process), and applications (Applications). If the TCS menu is not displayed using the current configuration profile, you can activate it by selecting View / Menu / TCS Menu.

- **The Toolbars**
  This area allows you to insert and customize individual (function) buttons. The advantage of the container is that it can be switched on or off with its entire contents of buttons. For this purpose, proceed as follows: View / Menu / Container.

- **The Document Viewer Window (Experiment Overview)**
  The Document Overview window displays the recorded experiments and their contents in a directory tree. Open this viewer window by selecting View / Experiment Overview.

- **The Status bar**
  The Status bar is found at the bottom edge of the Leica Confocal Software user interface. It displays:
  - the progress while loading image data (progress bar)
  - the version number of the software
  - the name of the system configuration (system type)

  For details about these functions, refer to the chapter on "The LCS Software Functions."
14.2. Opening and saving data sets

14.2.1. Readable File Formats

The following file formats can be opened and viewed in the Leica Confocal Software:

- **Experiment (*.lei):**
  The format of this type of file is Leica-specific and binary. This format is provided for the data of entire experiments.

- **TIFF files (*.tif):**
  These are Leica image files in single and multiple TIF format. Both image files in the previously used TCS formats and external files in RGB TIF format can be read.

- **Annotation (*.ano):**
  The format of this type of file is also Leica-specific and binary. It is used for saving annotation sheets. The elements on the annotation sheet, such as images, texts and graphic images, are each available as individual objects.

When these files are loaded, both the image data and the experiment settings are loaded.

14.2.2. Automatically Applying the Study Parameters of an Experiment

With the Leica Confocal Software, hardware settings that have been saved for previous experiments or single images can be applied to new experiments. This allows you to carry out different experiments using constant settings. To carry over settings from a previous experiment, open the viewer window for the data record that contains the settings you want to apply. There, click the "Apply" button, which, in the factory default configuration profile, is located in the toolbar.

If you do not find the "Apply" button in one of the open windows, you can load it into any of the windows by selecting Tools / Customize. In the dialog window that appears, select the "Commands" tab under the file category:File. With the left mouse button, click the "Apply” button and drag it while holding the mouse button pressed to the desired window. Release the left mouse button to insert the button at the current location.
14.2.3. Saving Images

As described above under "Readable File Formats", individual images and experiments can be saved using the same data formats.

Select File → Save to save your images and experiments. The first time an experiment is saved, the "Save as" dialog opens automatically, allowing you to specify a file name. In addition to defining a suitable file name, you can also select a file format here. Experiments can only be saved in the Leica specific *.lei−Format. When you are saving experiments, you may be able to save existing individual images in *.tif or *.raw format.

If you are saving an experiment or image that has already been saved before, the old data will be overwritten. If you do not want to do this, select File → Save as to save the new or changed data to a new file with a new name.

14.2.4. Data Organization by Grouping Experiments

The concept of the Leica Confocal Software allows you to group individual images, image series and the results of edited images into single groups, or experiments. The Experiment Overview window provides a general overview of the open experiment. To open the Experiment Overview window, select View / Experiment Overview. Create a new experiment by selecting File / New or File / New (Template). Files that were previously saved are handled as separate experiments when opened.

14.2.5. Compiling Experiments

After you have defined a new experiment by selecting File / New or File / New (Template), you can start filling it with data.

Images that have been recorded in continuous scan mode are overwritten automatically when the next scan is started. If you want to keep a single recording as a permanent part of an experiment, you should use the single scan function.

An experiment contains data acquired with the "single scan" or "series scan" function. If you carry out image processing functions on a data record, you can save the results as additional components of the experiment. To do this, double-click the desired image or series in the experiment overview window. Carry out the desired image processing functions (such as maximum projection or topological image or others). Mark the region within the viewer window that you want to keep as part of the experiment. Click the right mouse button (to open the context menu) and select Send to / Experiment.

The Selection (raw) option stores a copy of the raw data of the selected object as a new, separate component of the experiment. The Selection (snapshot) option stores an RGB image (no 3D data, just a pure snapshot) of the selected object as a new, separate component of the experiment.
14.3. Keyboard Shortcuts

In order to accelerate recurring software functions, special key combinations have been defined:

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Opens online help.</td>
</tr>
<tr>
<td>ALT + F8</td>
<td>Opens the Macros dialog window for launching, editing, and deleting macros.</td>
</tr>
<tr>
<td>ALT + F9</td>
<td>Opens a dialog window containing predefined macros that can be started from this dialog window.</td>
</tr>
<tr>
<td>ALT + F10</td>
<td>Starts the online help for the LCS macro language.</td>
</tr>
<tr>
<td>ALT + F11 (optional)</td>
<td>Launches the VBA developmental environment (optional).</td>
</tr>
<tr>
<td>CTRL + I</td>
<td>This option allows you to install subsequently purchased licenses.</td>
</tr>
<tr>
<td>CTRL + J</td>
<td>Opens the Objective dialog window in order to define and select the microscope objectives.</td>
</tr>
<tr>
<td>CTRL + L</td>
<td>Opens the Legend Info dialog window in order to enter user-specific data that can be stored and displayed when documenting image recordings.</td>
</tr>
<tr>
<td>CTRL + M</td>
<td>Use this option to select the Leica microscope you are using.</td>
</tr>
<tr>
<td>CTRL + N</td>
<td>Opens a new experiment.</td>
</tr>
<tr>
<td>CTRL + O</td>
<td>Starts the Open dialog window to open an existing file.</td>
</tr>
<tr>
<td>CTRL + P</td>
<td>Opens the Printer Selection dialog window.</td>
</tr>
<tr>
<td>CTRL + S</td>
<td>Saves the active experiment.</td>
</tr>
<tr>
<td>CTRL + B</td>
<td>Opens the Beam Path Setting window to set the parameters required for the image recording.</td>
</tr>
</tbody>
</table>
14.4. Menu Functions

14.4.1. File Menu

The following functions can be carried out from the menu bar:

- **New:**
  This option opens a new experiment in a new window. The display properties of the new window are determined by the active defaults (see the chapter on "Default Settings and Templates").

- **New (Template):**
  This option opens a new experiment in a new window. The way in which the viewer window is displayed can be selected from a set of templates.

- **Open:**
  This option opens a previously saved experiment or a single data block (image data or annotation). The display properties of the new window are determined by the active defaults (see the chapter on "Default Settings and Templates").

- **Open (Template):**
  This option opens a previously saved experiment, a single data block or documentation files. The way in which the viewer window is displayed can be selected from a set of templates.

- **Close:**
  This option closes the current experiment. It does not save the experiment automatically before closing it.

  You are not asked whether you want to save the experiment before it is closed.

- **Close all:**
  This option closes all open experiments. It does not save the experiment automatically before closing it.

  You are not asked whether you want to save the experiment before it is closed.

- **Save:**
  Saves the current experiment.

- **Save as:**
  Saves the current experiment under a different name.

- **Save all:**
  Saves all experiments and the annotations sheets.

  If one or several experiments or annotation sheets were not saved previously using the "Save "command, it is necessary to enter file name and savings location for the corresponding experiment using a dialog window.
• **Recent files:**
  Opens one of the recently opened files.

• **Print:**
  Opens a dialog for printing the content of the currently active window.

• **Exit:**
  Terminates the program.

### 14.4.2. The View Menu

The following functions can be carried out from the menu bar:

• **Menus:**
  Use this option to switch TCS menu and the toolbar on and off.

• **Status bar:**
  This option switches the display of the status bar on and off at the bottom edge of the user interface of the LCS software.

• **Experiment Overview:**
  This option opens a window displaying the individual experiments and their components (data records, graphs, etc.) in the form of a tree. Double-click an experiment component within the Experiment Overview window to bring the corresponding viewer window to the foreground.

• **Hardware Legend:**
  This option toggles the display of the hardware legend on and off.

### 14.4.3. The Macro Menu

The following functions can be carried out from the menu bar:

• **Macros:**
  Depending on the software installed, either use this option to edit macros directly or just list and run them.

  You can edit and modify macros only if the complete, integrated VBA development environment (IDE) is installed.

• **Run Macros:**
  Opens a dialog window containing predefined macros that can be started from this dialog window.
• **Macro Interface Help:**
  Starts the online help for the LCS macro language.

• **Record a New Macro:**
  This starts the automatic macro recorder.

  For more information, refer to the documentation provided with the optional macro development environment.

• **Pause Recording:**
  This pauses the macro recorder.

• **Stop Recording:**
  This stops the macro recorder.

• **Visual Basic Editor (optional):**
  This option launches the software for developing macros and programs based on Visual Basic for Applications (VBA). Here you can edit and modify macros and even develop entire programs.

### 14.4.4. The Tools Menu

The following functions can be carried out from the menu bar:

• **Legend Info:**
  This option opens the dialog window for entering user-specific data. This data (e.g., name of institute, name of specimen, etc.) is saved with each data record and can be displayed next to the acquired images in the legend.

• **Objective:**
  This option opens the dialog window for defining applied objectives. The objectives you use can be made known to the software by copying them using "drag and drop" from the list provided in this dialog window.

  The correct information of the objective is important since some calculated values depend on it (e.g. scan field dimensions), automatic adaptation of the detection pinhole.

• **Microscope:**
  Use this option to select the Leica microscope you are using. This setting influences the way in which the microscope is controlled (for example, the motorized objective nose-piece).

• **Stains:**
  This option allows for manually entering values for dye characteristics.
• **Settings:**
Use this option to select the hardware settings that you want to be applied when opening a previously saved data record.

• **License:**
This option allows you to install subsequently purchased licenses. A subsequent license usually is installed if a software package offered as an option is purchased.

### 14.4.5. The Window Menu

The following functions can be carried out from the menu bar:

• **New Window:**
This option opens a new Viewer window within the same experiment. For example, you can use this function to view the same data record using different views (such as topographical and overlay views).

### 14.4.6. The Help Menu

The following functions can be carried out from the menu bar:

• **Contents:**
Opens the table of contents of the online help.

• **Search:**
Starts the search function for the online help.

• **Index:**
Opens the index of the online help.

• **Tutorials:**
Opens a tutorial in which the user is guided through selected processes step by step.

• **Set Language:**
Allows for selecting the language of the online help.
14.5. LCS File Formats

14.5.1. Formats of user-specific and device-dependent data

The LCS software provides the following file formats for user-specific data:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Directory: Leica</th>
<th>Directory: User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument data (Instrument Parameter Settings)</td>
<td>*.IPS</td>
<td>*.IPS</td>
</tr>
<tr>
<td>Macros</td>
<td>Company.mac</td>
<td>User.mac</td>
</tr>
<tr>
<td>Templates for operator console</td>
<td>*.pbo</td>
<td>PersonalProfile.pro</td>
</tr>
<tr>
<td>User profiles</td>
<td>CompanyProfile.pro</td>
<td>LastExitProfile.pro</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LastRecent.lst</td>
</tr>
<tr>
<td>Templates</td>
<td>*.prt</td>
<td>*.prt</td>
</tr>
<tr>
<td>Calibration data</td>
<td>Machine.lhw</td>
<td></td>
</tr>
<tr>
<td>Color Look-Up Tables</td>
<td>*.lut</td>
<td></td>
</tr>
<tr>
<td>User-specific profile as it was defined the last time in use</td>
<td></td>
<td>*.lst</td>
</tr>
</tbody>
</table>

In detail, the different file formats contain:

- ***.IPS**
  
  Instrument parameters are saved in this format. This includes hardware-based settings such as intensity of the individual laser lines, number of channels used simultaneously, type of main beam splitter used, position and bandwidth of individual spectrophotometer diaphragms and sensitivity of detectors. In addition to the default unchangeable instrument parameter sets that allow a quick adjustment of the hardware, any user can save custom instrument parameter sets in his personal user directory. This allows you to save the instrument parameters typical for your planned use so that they can be reproduced and made available for other experiments.

- ***.mac**
  
  Macros are saved in this format. Macros contain VBA (V isual B asic for A pplication) program code. Leica provides the individual program objects for controlling the confocal system in an object model. Additional information about the development of macros for controlling the confocal system can be found in the manual "The LCS Macro Language".

  The software includes factory-predefined macros that can be used without modifications or modified according to your particular needs. The self-designed or modified macros are stored in the respective user-defined directory.

- ***.pbo**
  
  Templates for the assignment of the control panel are saved in this format. These templates define which scan parameter is controlled by which rotary knob. This format also inclu-
des factory presets that have proven useful for most standard applications. Self-defined
templates are saved in the user-specific directory.

- ***.pro**

Specific profiles of the user interface are saved in this format. This includes which button
is located in which position on which toolbar. In addition, new toolbars can be defined or
existing toolbars can be displayed or hidden. The position of the toolbars—whether em-
bedded or freely movable—is also stored in a profile. This allows every user to save an
individual user interface. For example, system administrators can use this tool to create a
separate user interface for each knowledge level of the user (beginner, advanced, expert).

- ***.lst**

Besides the individual user-specific profiles, the user directory also contains the profile of
the last session as well as a list of the last four data records applied by the user.

- ***.prt**

Templates for the "Viewer" window are saved in this format. This allows for specifically sa-
ving the appearance and type of displayed information. An explanation of the individual
configuration options can be found in the chapter on "Viewer window".

- ***.lhw**

Calibration data and hardware settings of the confocal system are saved in this format.
This file may be edited only by service personnel certified by Leica Microsystems Heidel-
berg.

Changes to this file may result in serious, possibly irreparable damages to
the confocal system. Damage demonstrably resulting from changes to this
file by the user will result in a loss of warranty for the complete system.

- ***.lut**

Color look-up tables are saved in this format. They are used to assign the intensity values
measured by the detectors to each color. This allows to bring out not only the true color
display, but also certain intensity areas. More details can be found in the chapter on "Se-
lecting Color Look-Up Tables."
14.5.2. Fixed Leica-specific file formats

The following file formats can be opened and viewed in the Leica Confocal Software:

- **Raw data (*.raw)**

  The RAW format saves data as a linear two-dimensional array in the INTEL format. The column index of the array corresponds to the fastest scan dimension (in general the x-axis), while the line index corresponds to the slower scan dimension (in general the y-axis). In an 8-bit image, each measured variable is saved as a single byte. A 12-bit recording uses 2 bytes, whereby the first byte contains the more significant bits according to the INTEL format (little endian). Each optical section is saved for each channel in a separate file with the file extension .raw using the following naming convention: name of experiment_name of data record_channel number_z-dimension_number of optical section.raw

- **Experiments (*.lei)**

  The format of this type of file is Leica-specific and binary. This format is provided for the data of entire experiments.

  A file description is saved in this file format, referencing a series of image files in TIF format or RAW format.

- **Tiff files (*.tif)**

  These are Leica image files in single and multiple TIF format. Both image files in the previously used TCS formats and external files in RGB TIF format can be read.

- **Annotation (*.ano)**

  The format of this type of file is also Leica-specific and binary. It is used for saving annotation sheets. The elements on the annotation sheet, such as images, texts and graphic images, are each available as individual objects.

  Information on whether the stored measured variable is an intensity value or a height value is saved in the corresponding LEI file.

Displaying a 12-bit number in the INTEL format

<table>
<thead>
<tr>
<th>Least significant byte according to INTEL format</th>
</tr>
</thead>
<tbody>
<tr>
<td>$2^7$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Most significant byte according to INTEL format</th>
</tr>
</thead>
<tbody>
<tr>
<td>$2^{15}$</td>
</tr>
</tbody>
</table>
15. Specification of the "Lei" file format (version beta 2.000)

When a file is saved in the LCS software, a subdirectory is first created under the current directory.

The following files are saved in this subdirectory:

1. A description file whose structure is described below. This file is used for interpreting the data of an experiment through the LCS software.

2. The individual image files; naming image files is based on the following naming convention:

   NAME_channel number_dimensionIndex.

   Thus, Chloroplast_C1_Z1 means that "Chloroplast" is the name of the data record assigned by the user, that the image corresponds to the first optical section of a three-dimensional data stack (Z1), and that the data was acquired in the first detection channel (C1).

Figure 32: Example for saving an experiment in "Lei" format

15.1. Structure of description file

The description file can be read only by the LCS software.

It consists of a collection of various tables and contains the following structure:

### Header table

<table>
<thead>
<tr>
<th>Byte</th>
<th>Meaning</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ... 3</td>
<td>Byte arrangement</td>
<td>0x49494949 Intel LSB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0x4D4D4D4D4D Motorola MSB</td>
</tr>
<tr>
<td>4 ... 7</td>
<td>Identification for Leica &quot;Lei&quot; format</td>
<td>0x016033F0</td>
</tr>
<tr>
<td>8 ... 11</td>
<td>Version number</td>
<td>current: =x20000000</td>
</tr>
<tr>
<td>12 ... 15</td>
<td>Address of directory table A</td>
<td>any possible address within the complete length of the file</td>
</tr>
</tbody>
</table>
### Directory table A

<table>
<thead>
<tr>
<th>Address</th>
<th>Meaning</th>
<th>Entry data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address of A = A</td>
<td>Number of entries in this table</td>
<td>DWORD</td>
</tr>
<tr>
<td>A+4</td>
<td>Index of the first entry (represents a logical memory block, e.g., acquisition parameter (“hardware settings”) or image parameter (“dimensions”)</td>
<td>DWORD</td>
</tr>
<tr>
<td>A+8</td>
<td>Address A1 of the 1st entry</td>
<td>DWORD</td>
</tr>
<tr>
<td>A+12</td>
<td>Index of the first entry (represents a logical memory block, e.g., acquisition parameter (“hardware settings”) or image parameter (“dimensions”)</td>
<td>DWORD</td>
</tr>
<tr>
<td>A+14</td>
<td>Address A2 of the 2nd entry</td>
<td>DWORD</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

The length of the directory table depends upon the number of images and image data to be saved in an experiment (acquisition parameters, number of channels, number of optical sections, etc.).

Each entry in the directory table corresponds to a logical memory block.

### Block table Xn

<table>
<thead>
<tr>
<th>Address</th>
<th>Meaning</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 or A2 or A3.....Ai</td>
<td>Check digit</td>
<td>DWORD</td>
</tr>
<tr>
<td>Ai+ 4 Bytes</td>
<td>Description of the contents of the block table (currently not used)</td>
<td>DWORD</td>
</tr>
<tr>
<td>Ai+ 8 Byte</td>
<td>Version of entry</td>
<td>DWORD</td>
</tr>
<tr>
<td>Ai+ 12 Byte</td>
<td>Size of entry</td>
<td>DWORD</td>
</tr>
<tr>
<td>Ai+ 16 Byte</td>
<td>Begin of entry</td>
<td>The data type depends upon the entry type</td>
</tr>
</tbody>
</table>

The following logical memory blocks are available:

```plaintext
const DWORD ID_SERIES     = 10;
const DWORD ID.Images     = 15;
const DWORD ID_DIMDESCR   = 20;
const DWORD ID_FILTERSET  = 30;
const DWORD ID_TIMEINFO   = 40;
const DWORD ID_SCANNERSET = 50;
const DWORD ID_EXPERIMENT = 60;
const DWORD ID_LUTDESC    = 70;
```

A memory space of 32 bits is defined for the DWORD data type.
• **ID_SERIES memory block**
This data block contains information about the size of the complete data series combined in an experiment. It always occurs only once per experiment. The data block is structured as follows:

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Internal version number</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nSE</td>
<td>Number of image series</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nIm</td>
<td>Length of a file name in wchar</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nExt</td>
<td>Length of the file extension of the image file in bytes</td>
</tr>
<tr>
<td>nExt</td>
<td>wchar</td>
<td></td>
<td>File extension of image file</td>
</tr>
</tbody>
</table>

• **ID_IMAGES memory block**
This block contains all file names of all image files that are part of a series. The data block is structured as follows:

| 4 | int | nFiles | Number of single images of the series |
| 4 | int |        | Width of a single image                 |
| 4 | int |        | Length of a single image                |
| 4 | int |        | Bits / data points (image resolution)    |
| 4 | int |        | Data points / pixels (display resolution) |

For the next \( n \) image files:

| nIm * 2 | wchar     | Name of the next image |

• **ID_DIMDESCR memory block**
This block provides a description of an image in an n-dimensional space.

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Internal version number of the VOXEL description</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Voxel type, e.g., RGB or GRAY (see the follow-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ing VOXEL TYPES table)</td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td></td>
<td>Byte size of a pixel</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Typical: (1 or 2) or (3 or 6 for RGB)</td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td></td>
<td>Resolution of scan data (8, 12 or 16 bit)</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in wchar (wchar =</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>wide character; character format that uses</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>a 2-byte coding of characters unlike the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ASCII format (1 byte).</td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>Maximum value of measured variable (intensity value or length value of a distance) for a voxel</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
<td>------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
<td></td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>Minimum value of measured variable (intensity value or length value of a distance) for a voxel</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
<td></td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>Designation of measured variable (&quot;I&quot; for intensity, &quot;z&quot; for length value)</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Internal version number</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nDims</td>
<td>Dimension of the image, e.g., x_y_ch_z = 4</td>
<td></td>
</tr>
<tr>
<td>4 DWORD</td>
<td>Identification number (ID) of the dimension (see the following list &quot;Identification numbers (ID) for image dimensions&quot;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 DWORD</td>
<td>Size of dimension (e.g., 512 pixel)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 DWORD</td>
<td>Distance between sub–dimensions (e.g., byte distance between the image series of two consecutive channel numbers)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
<td></td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>Physical length with unit of length, e.g., 10 µm</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
<td></td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>Physical start position with unit of length, e.g., 10 µm</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in bytes</td>
<td></td>
</tr>
<tr>
<td>nTC</td>
<td>wchar</td>
<td>Name of the image series</td>
<td></td>
</tr>
<tr>
<td>4 int</td>
<td>nTC</td>
<td>Length of the following string in bytes</td>
<td></td>
</tr>
<tr>
<td>nTC</td>
<td>wchar</td>
<td>Description of the image series</td>
<td></td>
</tr>
</tbody>
</table>
• **Identification numbers (ID) for image dimensions**

The following identification numbers are possible:

<table>
<thead>
<tr>
<th>ID (decimal)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>undefined</td>
</tr>
<tr>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>116</td>
<td>t for time dimension</td>
</tr>
<tr>
<td>6815843</td>
<td>channel number</td>
</tr>
<tr>
<td>6357100</td>
<td>wavelength Range</td>
</tr>
<tr>
<td>7602290</td>
<td>Rotation</td>
</tr>
<tr>
<td>7798904</td>
<td>x–wide for motorized xy–stage</td>
</tr>
<tr>
<td>7798905</td>
<td>y–wide for motorized xy–stage</td>
</tr>
<tr>
<td>7798906</td>
<td>z–wide for z–stage</td>
</tr>
<tr>
<td>4259957</td>
<td>user1 (not specified)</td>
</tr>
<tr>
<td>4325493</td>
<td>user2 (not specified)</td>
</tr>
<tr>
<td>4391029</td>
<td>user3 (not specified)</td>
</tr>
<tr>
<td>6357095</td>
<td>gray–scale, e.g., of histogram</td>
</tr>
<tr>
<td>6422631</td>
<td>gray–scale1, e.g., of histogram</td>
</tr>
<tr>
<td>6488167</td>
<td>gray–scale2, e.g., of histogram</td>
</tr>
<tr>
<td>6553703</td>
<td>gray–scale3, e.g., of histogram</td>
</tr>
<tr>
<td>7864398</td>
<td>logical x (not physical, but logical position value)</td>
</tr>
<tr>
<td>7929934</td>
<td>logical y (not physical, but logical position value)</td>
</tr>
<tr>
<td>7995470</td>
<td>logical z (not physical, but logical position value)</td>
</tr>
<tr>
<td>7602254</td>
<td>logical t (not physical, but logical position value)</td>
</tr>
<tr>
<td>7077966</td>
<td>logical wavelength value (not physical, but logical value)</td>
</tr>
<tr>
<td>7471182</td>
<td>logical rotation value (not physical, but logical value)</td>
</tr>
<tr>
<td>5767246</td>
<td>logical x–wide value (not physical, but logical value)</td>
</tr>
<tr>
<td>5832782</td>
<td>logical y–wide value (not physical, but logical value)</td>
</tr>
<tr>
<td>5898318</td>
<td>logical z–wide value (not physical, but logical value)</td>
</tr>
</tbody>
</table>

• **ID_FILTERSET memory block**

This memory block describes the hardware settings such as pinhole diameter or selected filters. The memory block starts with a SAFEARRAY header that describes the number and size of the entries. A complete description of the SAFEARRAY structure can be found in Appendix 1.

Presently, only three entries of the SAFEARRAY structure are used:

1. **sa.CDims**: should be = 1. Presently, only one-dimensional data fields (arrays) are used.
2. **sa.cbElements**: Size of elements in byte

3. **sa. rgsabound[0].cElements**: indicates the number of elements contained in the structure.

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>SAFEARRAY</td>
<td>sa</td>
<td>Microsoft type, see Appendix 1 for all elements that contain the structure = sa.rgsabound[0].cElements</td>
</tr>
<tr>
<td>128</td>
<td>wchar</td>
<td>Identifier for the contents of the entry</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>wchar</td>
<td>Name of a short description, e.g., a TIFF description tag</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>wchar</td>
<td>String (contains the contents of the string)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>VARIANT</td>
<td>Contains the data type and data value (except for the &quot;string&quot; data value which is described in the field above)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Separate memory space for data values</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Not in use</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Identifier (ID) of the memory block (for internal use only)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Test value</td>
<td></td>
</tr>
</tbody>
</table>
**ID_TIMEINFO memory block**

This memory block contains the time taggers for image series that were acquired with a time-dependent scan mode.

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>int</td>
<td>nDims</td>
<td>Indicates the number of dimensions that the description of the time tagger includes</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Indicates which dimension was provided with a time tagger</td>
</tr>
</tbody>
</table>

For the next $n$ dimensions

| 4 | DWORD | D | Identifier (ID) of the dimension (see the description of the D_DIMDESCR memory block) |
| 4 | DWORD | D | Size of the dimension (number of elements, e.g., 512 pixel) |
| 4 | DWORD | D | Distance between the individual dimension entries |
| 4 | int   | nTS | Number of time taggers |

For the next $n$ time taggers = $nTS$

| 64 | wchar | | Time tagger as string (“string” data type) |
| 4  | int   | nTM | Number of time tags per time tagger |

For the next $m$ time tags = $nTM$

| loop nC |
| 4 | int | nC | Number of dimensions of the time tagger description |

| loop nC |
| 4 | int | | Coordinate in this dimension |
| 64 | wchar | | Time tag as string (wchar data type) |

**Example:**

Image with the following dimensions and dimension sizes:

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>y</td>
<td>ch</td>
<td>z</td>
<td></td>
</tr>
<tr>
<td>512</td>
<td>512</td>
<td>3</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

For example, the description of a time tag is 512_512_3_10. This description matches the description of the image. The time tagger description 1024_1024_3_10 for the above sample image means that the original image featured an xy-dimension of 1024*1024 and was reduced by the software (downsampling). In such cases, the time tag must be recalculated accordingly.
A time tag can be defined at any time during an n-dimensional data acquisition process (scan). The coordinate of the time tag 0_0_2_7 indicates that the time tag was set at the start of a data record (0_0_c_#) on the second channel (0_0_2_) for the 7th optical section (0_0_2_7).

- **ID_SCANNERSET memory block**

  This memory block contains device parameters that are set at the time of the image acquisition.

  Further details about the SAFEARRAY structure can be found in the description of the ID_FILTERSET memory block.

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>SAFEARRAY</td>
<td>sa</td>
<td>Microsoft type, see Appendix for all elements that contain the structure = sa.rgsbound[0].cElements</td>
</tr>
<tr>
<td>128</td>
<td>wchar</td>
<td>Identifier for the contents of this entry</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>wchar</td>
<td>Name of a shorthand notation, e.g., a TIFF description tag</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>wchar</td>
<td>String (contains the contents of the string)</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>VARIANT</td>
<td>Contains the data type and data value (except for the &quot;string&quot; data value which is described in the field above)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Separate memory space for data values</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Not in use</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Identifier (ID) of the memory block (for internal use only)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DWORD</td>
<td>Test value</td>
<td></td>
</tr>
</tbody>
</table>
**ID_EXPERIMENT memory block**

Description of the used save format (e.g., "*.lei file with PC-Tiff images")

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Internal version number</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Number of images in the data collection of the experiment</td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Short description of the format</td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td>nTC</td>
<td>Identifier of the single image format (e.g., PC-TIFF)</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in wchar</td>
</tr>
<tr>
<td>nTC * 2</td>
<td>wchar</td>
<td></td>
<td>File extension for the single image format (e.g., tif / raw)</td>
</tr>
</tbody>
</table>

**ID_LUTDESC memory block**

Description of the color look-up tables (LUTs)

<table>
<thead>
<tr>
<th>Size [byte]</th>
<th>Data type</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>int</td>
<td>nLU</td>
<td>Number of channels</td>
</tr>
<tr>
<td>4</td>
<td>DWOR D</td>
<td></td>
<td>Identifier (ID) of the dimension whose display is being colored.</td>
</tr>
<tr>
<td>For the next channels until = nLU</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Internal version number</td>
</tr>
<tr>
<td>1</td>
<td>bool</td>
<td></td>
<td>bool IsInverted</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in bytes</td>
</tr>
<tr>
<td>nTC</td>
<td>wchar</td>
<td></td>
<td>Description of the color look-up table (LUT)</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in bytes</td>
</tr>
<tr>
<td>nTC</td>
<td>wchar</td>
<td></td>
<td>File name of the color look-up table (if available)</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td>nTC</td>
<td>Length of the following string in bytes</td>
</tr>
<tr>
<td>nTC</td>
<td>wchar</td>
<td></td>
<td>Name of the color look-up table</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Field for internal use</td>
</tr>
<tr>
<td>4</td>
<td>int</td>
<td></td>
<td>Dimension of the color look-up table</td>
</tr>
</tbody>
</table>
SAFEARRAY Data Type

typedef struct FARSTRUCT tagSAFEARRAY {
    unsigned short cDims;        // Count of dimensions in this array
    unsigned short fFeatures;    // DON'T CARE
    unsigned long cbElements;    // Size of an element of the array.
    // Does not include size of
    // pointed-to data.
    unsigned long cLocks;        // DON'T CARE
    void HUGEP* pvData;          // Pointer to the data.
    SAFEARRAYBOUND rgsabound[1]; // One bound for each dimension.
} SAFEARRAY;

The Leica-specific file format "LEI" uses only one-dimensional data fields (arrays).

SAFEARRAYBOUND Structure
Represents the bounds of one dimension of the array. The lower bound of the dimension is represented by iLbound, and cElements represents the number of elements in the dimension. The structure is defined as follows:

typedef struct tagSAFEARRAYBOUND {
    unsigned long cElements; // num of elements
    long iLbound;            // DON'T CARE
} SAFEARRAYBOUND;

VARIANT and VARIANTARG

typedef struct FARSTRUCT tagVARIANT VARIANT;
typedef struct tagVARIANT { 
    VARTYPE vt;
    unsigned short wReserved1;
    unsigned short wReserved2;
    unsigned short wReserved3;
    union {
        union {
            unsigned char bVal;    // VT_UI1.
            short iVal;            // VT_I2.
            long lVal;             // VT_I4.
            float fltVal;          // VT_R4.
            double dblVal;         // VT_R8.
            VARIANT_BOOL boolVal;  // VT_BOOL.
            SCODE scode;           // VT_ERROR.
            CY cyVal;              // VT_CY.
            DATE date;             // VT_DATE.
            BSTR bstrVal;          // VT_BSTR.
            IUnknown FAR* punkVal; // VTUNKNOWN.
        }
    }
} SAFEARRAYBOUND;
Files with the "LEI" format never use pointers as parameters.

- **VARTYPE**

typedef unsigned short VARTYPE;
enum VARENUM{
    VT_EMPTY = 0,  // Not specified.
    VT_NULL = 1,   // Null.
    VT_I2 = 2,     // 2-byte signed int.
    VT_I4 = 3,     // 4-byte signed int.
    VT_R4 = 4,     // 4-byte real.
    VT_R8 = 5,     // 8-byte real.
    VT_CY = 6,     // Currency.
    VT_DATE = 7,   // Date.
    VT_BSTR = 8,   // Binary string.
    VT_DISPATCH = 9, // IDispach
    VT_ERROR = 10, // Scodes.
    VT_BOOL = 11,  // Boolean; True=-1, False=0.
    VT_VARIANT = 12, // VARIANT FAR*
    VT_UNKNOWN = 13, // IUnknown FAR*
    VT_UI1 = 17,   // Unsigned char.

    // Other constants that are not valid in VARIANTS omitted here.
};

VT_RESERVED = (int) 0x8000
// By reference, a pointer to the data is passed.
VT_BYREF  = (int) 0x4000
VT_ARRAY   = (int) 0x2000  // A safe array of the data is passed.

The vt value determines the interpretation of the data of the experiment as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT_EMP TY</td>
<td>No value was entered</td>
</tr>
<tr>
<td>VT_UI1</td>
<td>An unnamed 1-byte character was saved in bVal.</td>
</tr>
<tr>
<td>VT_I2</td>
<td>A 2-byte integer value was saved in iVal.</td>
</tr>
<tr>
<td>VT_I4</td>
<td>A 4-byte integer value was saved in lVal.</td>
</tr>
<tr>
<td>VT_R4</td>
<td>An IEEE 4-byte real value was saved in fltVal.</td>
</tr>
<tr>
<td>VT_R8</td>
<td>An IEEE 8-byte real value was saved in dblVal.</td>
</tr>
<tr>
<td>VT_CY</td>
<td>A fixed point value is indicated. It consists of 15 digits before the point and 4 digits after the point. The value was saved in cyVal.</td>
</tr>
<tr>
<td>VT_BST R</td>
<td>Exceptions for files in LEI format: A string was saved in the variable TCHAR</td>
</tr>
<tr>
<td>VT_NUL L</td>
<td>A floating zero value was indicated. Here, the floating zero is not a NULL pointer. This value is required for a 3-state logic, for example, in the SQL database query language.</td>
</tr>
<tr>
<td>VT_ER- ROR</td>
<td>An SCODE error was indicated. The error type is specified sco- dee.</td>
</tr>
<tr>
<td>VT_BOO L</td>
<td>A Boolean value (true / false) was indicated. The value 0xFFFF (all bits=1) means &quot;true,&quot; the value 0 (all bits=0) means &quot;false.&quot;</td>
</tr>
<tr>
<td>VT_DATE</td>
<td>A value corresponding to a date was indicated. A date is saved as a number in double-precision format. All data is saved as differential dates in reference to January 1, 1900. For example, the entry &quot;25&quot; corresponds to 01–25–1900.</td>
</tr>
</tbody>
</table>
16. Introduction to the Leica Confocal Software Help

The system comes with a context-sensitive online help system that explains the different functions of the system.

Three different help levels are available:

16.1. Quick Help

When you let the mouse pointer hover over a Leica Confocal Software button, a brief explanation of the function of this button is displayed. This so-called Help Banner automatically disappears when the mouse pointer is moved.

16.2. Context-sensitive Help

Click Help to open the context-sensitive online help function, which provides you with short explanations for the various buttons and functions of the Leica Confocal Software.

1. Click on the Help button.
2. A question mark appears next to the mouse pointer. This temporarily disables the functions of all buttons.
3. Use the mouse pointer to click the button that you want an explanation of.
4. Online help opens directly to the description for the corresponding button.

Online help also provides you with an index of key words and a search function so that you can search for specific topics and buttons. Furthermore, you can print the individual descriptions.

You can also open the online help by selecting Contents, Search or Index option under the Help menu.

If the Help button is not present on the user interface:

1. Select the Customize option from the Tools menu. Here you will find all buttons arranged by categories.
2. The Help button can be found in the File category.
3. Click on it using the left mouse button and drag it to the desired window.
16.3. Retrieving help topics using the table of contents

Select Help / Contents. The online help system opens with an activated CONTENTS window.

It shows a collapsible table of contents.

Double-click an entry of the table of contents to view the corresponding information.

16.4. Retrieving help topics using a keyword

Select Help / Index. The online help system opens with an activated INDEX window.

Enter the word you want to look up. The online help shows the key word that represents the closest match to the word you entered.

Select a key word. View the corresponding content pages by double-clicking the key word or selecting it and then clicking the Display button.

16.5. Retrieving help topics using the full-text-search

Select Help / Search. The online help system opens with an activated SEARCH window.

Enter the term or definition you want to look up and click on the LIST TOPICS button.

A hierarchically structured list of topics is returned.

Click on the triangle to the right of the input field to view the available logical operators. Select the desired operator. Enter the second search word you would like to associate with the first search word behind the operator:

<table>
<thead>
<tr>
<th>Examples</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pinhole AND Sections</td>
<td>This phrase finds help topics containing both the word &quot;pinhole&quot; and the word &quot;sections&quot;.</td>
</tr>
<tr>
<td>Pinhole OR Sections</td>
<td>This phrase finds help topics containing either the word &quot;pinhole&quot; or the word &quot;sections&quot; or both.</td>
</tr>
<tr>
<td>Pinhole NEAR Sections</td>
<td>This phrase finds help topics containing the word &quot;pinhole&quot; and the word &quot;sections&quot; if they are located within a specific search radius. This method also looks for words that are similar in spelling to the words specified in the phrase.</td>
</tr>
<tr>
<td>Pinhole NOT Sections</td>
<td>This phrase finds help topics containing the word &quot;pinhole&quot; and not containing the word &quot;sections&quot;.</td>
</tr>
</tbody>
</table>
16.6. Favorites
If you select Favorites in the dialog window of the online help tab, you can include the current help topic in a list, making them easily available for future use.

16.7. Documentation Conventions

- **Button**
The buttons provided on the user interface of the Leica Confocal Software. Buttons are marked with icons and/or have an (often abbreviated) English label. They either trigger actions directly or open dialog windows.

- **Menu**
The menus are divided into the categories of File, View, Macro, Tools, Window and Help and are displayed in the menu bar located at the upper edge of the user interface.

- **Option**
Options refer to the selectable items that are hierarchically listed below the menus. Options either trigger actions directly or open dialog windows.

- **Dialog Window**
Both buttons and options open dialog windows. Dialog windows are used to set various parameters and select functions.

- **Register**
Registers are found in dialog windows. Registers thematically combine the parameters and functions that can be configured in dialog windows. Some registers are divided into fields.

- **Viewer window**
The Leica Confocal Software contains two types of viewer window. The Viewer window is called up by pressing the New button and displays the recorded images. The Experiment Overview viewer window displays the recorded images in a directory tree. This viewer window is called up from the View menu and appears as a separate window at the left side of the user interface.

- **Legend**
The Leica Confocal Software provides two legends, which display the parameters and settings of an image recording. The Experiment legend can be placed at the right edge of the Viewer window. The Hardware legend is called up from the View menu and appears as a separate window at the left side of the user interface.

- **Context Menu**
Context menus appear when you click the right mouse button while holding the mouse pointer over certain areas of the user interface. Context menus contain various, context-sensitive commands.
16.8. Performing a task

Following the heading that introduces a task are either sequential steps or optional steps, each with its distinctive style.

Usually there is a sequence. Perform one or more of the steps to cause the designated action or actions.
17. Help via the Internet

First contact your local Leica subsidiary or the local dealer.

You can also find information on Leica Microsystems Heidelberg GmbH and confocal microscopy on our website at


Or send an e-Mail to CLSM.Support@leica-microsystems.com.
18. Maintenance and Cleaning

Please refer to the corresponding manuals for information on how to maintain the Leica research microscope.

The instructions and additional information relating to the components of the confocal system are summarized below.

18.1. Selecting an installation site

- Do not expose the system to draft.
  Ensure that the system is not installed next to elevators, air conditioners or other inlets and outlets. For this reason, the installation site should be carefully planned.
- Protect the microscope from dust and grease.
  When not in use, the system should be covered with a plastic foil (part of delivery) or a piece of cotton cloth. The system should be operated in a room which is kept as dust and grease-free as possible.
  Dust caps should always be placed over the objective nosepiece positions when no objective is in place.
- Exercise care in the use of abrasive chemicals.
  You must be particularly careful if your work involves the usage of acids, lyes or other aggressive chemicals. Make sure to keep such substances away from optical or mechanical components.

18.2. Cleaning the optical system of the microscope

The optical system of the microscope must be kept clean. Under no circumstances should users touch the optical components with their fingers or anything which may bear dust or grease.

Remove dust by using an air puffer (not solvent-based) or a fine, dry hair pencil. If this method fails, use a piece of cloth, moistened with distilled water.

Persistent dirt can be removed from glass surfaces by means of pure alcohol, chloroform or naphtha.

If an objective lens is accidentally contaminated by unsuitable immersion oil or by the specimen, please contact your local Leica representative for advice on the use of certain solvents for cleaning purposes.

Take this seriously, because some solvents may dissolve the glue which holds the lens in place.
**Do not open objectives for cleaning.**

Oil should be removed from oil immersion lenses after use.

First, remove the immersion oil using a clean cloth. Once most of the oil has been removed with a clean tissue, a piece of lens tissue should be placed over the immersion end of the lens. A drop of recommended solvent should be applied, and the tissue gently drawn across the lens surface. This should be repeated as often as necessary to attain total cleanliness. Use a clean piece of lens tissue each time.

### 18.3. Cleaning the microscope surface

Use a linen or leather cloth (moistened with naphtha or alcohol) to clean the surfaces of the microscope housing or the scanner (varnished parts).

**Never use acetone, xylene or nitro thinners as they attack the varnish.**

All LEICA components and systems are carefully manufactured using the latest production methods. If you encounter problems in spite of our efforts, do not try to fix the devices or the accessories yourself, but contact your Leica representative.

**Before moving the confocal system, it should be thoroughly cleaned. This applies in particular to systems that are located in biomedical research labs.**

This is necessary to remove any existing contamination and to prevent any carry-over and endangering of others. Pay not only attention to surfaces, but especially to fans and cooling devices since dust can frequently accumulate at these locations.
19. Optional trigger control panel

19.1. Description of Function

The optional trigger control panel is used for controlling incoming and outgoing trigger signals. In addition, trigger signals can be actuated manually to control recording sequences.

The control panel can be ordered from the appropriate Leica branch office using part number 156108330.

![Figure 33: Front side of the trigger control panel](image)

<table>
<thead>
<tr>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 1 or an external trigger signal arrives via T1 connection (rear side of the trigger control panel)</td>
</tr>
<tr>
<td>T2</td>
<td>Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 2 or an external trigger signal arrives via T2 connection (rear side of the trigger control panel)</td>
</tr>
<tr>
<td>T3</td>
<td>Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 3 or an external trigger signal arrives via T3 connection (rear side of the trigger control panel)</td>
</tr>
<tr>
<td>T4</td>
<td>Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 4 or an external trigger signal arrives via T4 connection (rear side of the trigger control panel)</td>
</tr>
<tr>
<td>Out4</td>
<td>Signal lamp; illuminates if an outgoing trigger signal is emitted via trigger channel 4 (standard TTL signal)</td>
</tr>
<tr>
<td>L</td>
<td>Signal lamp; indicates the line signal. This lamp illuminates during the time in which data is recorded during the line scan.</td>
</tr>
<tr>
<td>F</td>
<td>Signal lamp; indicates the frame signal. This lamp illuminates during the time in which a single frame is recorded.</td>
</tr>
<tr>
<td>L/F</td>
<td>The logical AND operation between the line signal L and the frame signal F</td>
</tr>
</tbody>
</table>
Optional trigger control panel

| TM1 | Push button; activating this push button creates a trigger signal on trigger channel 1. This signal can be recorded and processed by the confocal system. |
| TM2 | Push button; activating this push button creates a trigger signal on trigger channel 2. This signal can be recorded and processed by the confocal system. |
| TM3 | Push button; activating this push button creates a trigger signal on trigger channel 3. This signal can be recorded and processed by the confocal system. |
| TM4 | Push button; activating this push button creates a trigger signal on trigger channel 4. This signal can be recorded and processed by the confocal system. |

**Figure 34:** Rear side of the trigger control panel

<table>
<thead>
<tr>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger out</td>
<td>Connection socket for connecting the trigger-out socket on the rear side of the supply unit</td>
</tr>
<tr>
<td>9V DC / 100 mA</td>
<td>Voltage supply of the trigger control panel</td>
</tr>
<tr>
<td>T1</td>
<td>Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)</td>
</tr>
<tr>
<td>T2</td>
<td>Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)</td>
</tr>
<tr>
<td>T3</td>
<td>Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)</td>
</tr>
<tr>
<td>T4</td>
<td>Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)</td>
</tr>
<tr>
<td>Out4</td>
<td>Connection which is used to emit a trigger signal generated by the confocal system (standard TTL)</td>
</tr>
<tr>
<td>L</td>
<td>Line signal. This signal is on logical &quot;1&quot; during the time in which data is recorded during a line scan.</td>
</tr>
<tr>
<td>F</td>
<td>Frame signal. This signal is on logical &quot;1&quot; during the time in which data is recorded during a single image (frame).</td>
</tr>
<tr>
<td>L/F</td>
<td>The logical AND operation between the line signal L and the frame signal F</td>
</tr>
</tbody>
</table>
19.2. Installation

The trigger control panel is connected to the confocal system as follows:

1. The supplied ribbon cable is connected to the "Trigger out" connection socket at the rear side of the operator panel and to the connection of the same name at the rear side of the supply unit.

2. The trigger control panel must be connected to the supplied power supply, and the power pack must be connected to 230 V AC.

Figure 35: Connection of the trigger control panel

19.3. Application

External trigger signals (connection sockets "T1"-"T4") can be transmitted to the confocal system via trigger control panel using a BNC cable.

Outgoing trigger signals can be transmitted to external devices via "Out4" connection socket.

The "TM1" - "TM4" push button can be used for testing purposes.
20. Declaration of Conformity

Manufacturer: Leica Microsystems Heidelberg GmbH
Address: Am Friedensplatz 3
         Germany, 68165 Mannheim
Product: TCS SP2 MP  Confocal Laser Scanning Microscope

We declare that the product described herein complies with the following European Directives:

89/336/EEC Directive on Electromagnetic compatibility
73/23/EEC Directive on Low-voltage equipment

The product conforms to the standards:

EMC requirements for Class A electrical equipment for measurement, control and laboratory use

EN 61000-3-2: 2000
Electromagnetic compatibility (EMC)
Part 3-2: Limits – Limits for harmonic current emissions

EN 61000-3-3: 1995
Electromagnetic compatibility (EMC)
Part 3: Limits – Section 3: Limitation of voltage fluctuations and flicker in low-voltage supply systems for equipment with rated current ≤ 16A

EN 61010-1: 2001
Safety requirements for electrical equipment for measurement, control and laboratory use; Part 1: General requirements

Safety of laser products
Part 1: Equipment classification, requirements and user's guide

Manager Research & Development

Mannheim, Germany
January 01, 2004

Dr. Rafael Storz
Index

B
Beam coupling, Page 11

C
Changing the Scanner, Page 65
Cleaning, Page 98
Climatic requirements, Page 10
Confocal imaging, Page 42
Confocal observation, Page 50
Context-sensitive Help, Page 93
Conventional observation, Page 48
Cooling power, Page 10

D
Declaration of Conformity, Page 103
Description file, Page 81
Detection, Page 43
Dimensionen, Page 7
Dimensions, Page 10
Direct coupling, Page 7
Disclosure, Page 2
Document Symbols, Page 5

E
E-Mail, Page 97
Electrical connection requirements, Page 10

F
Fiber coupling, Page 9
File Formats, Page 78
Full-text-search, Page 94

H
Heat emission, Page 10
Help, Page 93
Help topics, Page 94

I
Image processing, Page 44
Installation site, Page 98
Internet, Page 97

K
Keyboard Shortcuts, Page 73
Keyword, Page 94
Köhler illumination, Page 59

L
Laser Class, Page 10
Laser safety housing, Page 11
Leica Confocal Software, Page 68
Leica subsidiary, Page 97
Light source, Page 45

M
Maintenance, Page 98
Menu, Page 69
Menu Functions, Page 74
Microscope surface, Page 99
Multiphoton system, Page 11

O
Operating System, Page 57
Optical resolution, Page 43

Q
Quick Help, Page 93
<table>
<thead>
<tr>
<th>R</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readable File Formats, Page 71</td>
<td>TCS Menu, Page 69</td>
</tr>
<tr>
<td></td>
<td>Toolbars, Page 70</td>
</tr>
<tr>
<td></td>
<td>Trademarks, Page 2</td>
</tr>
<tr>
<td></td>
<td>Trigger control panel, Page 100</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Saving Images, Page 72</td>
<td></td>
</tr>
<tr>
<td>Service call, Page 12</td>
<td></td>
</tr>
<tr>
<td>Setting the Köhler illumination, Page 60</td>
<td></td>
</tr>
<tr>
<td>Setting Up Users, Page 58</td>
<td></td>
</tr>
<tr>
<td>Software License, Page 3</td>
<td></td>
</tr>
<tr>
<td>Starting the Software, Page 68</td>
<td></td>
</tr>
<tr>
<td>Starting-up, Page 46</td>
<td></td>
</tr>
<tr>
<td>Status bar, Page 70</td>
<td></td>
</tr>
<tr>
<td>Switching off, Page 63</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>Viewer Window, Page 69</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Warranty, Page 2</td>
<td>Weight, Page 10</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>